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Getting Started With
SystemTest

This section explains what SystemTest is and shows you how to use it. It
contains the following topics:

What Is SystemTest? (p. 1-2) Introduces SystemTest and the kinds
of tasks it can perform

A Quick Tour of SystemTest (p. 1-3)  Provides a quick tour of the
SystemTest Desktop

Building a Test: An Example (p. 1-7) Describes building and running tests
with SystemTest
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What Is SystemTest?

SystemTest provides MATLAB® and Simulink® users a framework that
integrates software, hardware, simulation, and other types of testing in one
environment. You use predefined elements to build test sections that simplify
the development and maintenance of standard test routines. You can save
and share tests throughout a development project to ensure standard and
repeatable test verification. SystemTest offers integrated data management
and analysis capabilities for creating and executing tests, and saving test
results in order to enable continuous testing across the development process.

SystemTest automates testing in MATLAB and Simulink products. With
SystemTest you get:

Graphical test editing — Quickly edit your test within a graphical test
development environment.

Repeatable test execution — Tests developed with SystemTest all share the
same execution flow, which provides a consistent test framework among
tests.

Parameterized testing — Create test vectors over which your test iterates.

Reusability — After you design a test, you can save it for later use by you
or others.

Maintainability — Because you design and execute tests from within the
SystemTest Desktop, you do not need to understand unfamiliar code or
concepts.

Integration — SystemTest integrates with MATLAB, Simulink, and other
MATLAB and Simulink-based products.
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A Quick Tour of SystemTest

The SystemTest Desktop is an integrated development environment that lets
you perform all of your testing activities from one centralized location. This
section provides a brief overview of the SystemTest environment. For more
information about how to use SystemTest to build tests and run them, see
“Building a Test: An Example” on page 1-7.

Getting Familiar with the Desktop

To get familiar with the SystemTest environment, open the SystemTest
Desktop from MATLAB by selecting Start > MATLAB > SystemTest >
SystemTest Desktop or typing systemtest at the MATLAB command line.

Test Browser Help
4 =lolx]
File Run Tools Deskbop |Window Help
® ™| G % | % curertDiectory: | Dok .
A X " X A ox
My BT = X Test Results Save Options Test =1
= Lllntitied b ivorkUntiled mat *
Pre Test & o e tost resut Uses elernents, test variables, test vectors,
=I-Rerations (1) eI test et and test results.
Main Test ™ Creste new numbersd test resutts (ex Results(l) wat) + Elements represent actions for the test 1o
Tl AL This Test Passes i petfortn, such as evaluating a MATLAB
Post Test script or sifmulating a Simulink model.
& Ay fii o i
Al lienit check elements in an iterstion pass + Test variables are used to tempnrar\ly
" Any limit check element in an iteration passes store data for use by test elements during
T execution. You can initialize variables in f
the Pre Test or Main Test with any
+ Al terations pass MATLAB expression
" Any iteration passes + Test vectors specify the values that vary
during each test iteration. SystemTest lets
[V Launch Test Results Wiewer after all results are saved you uge multiple test vectars whose values
are arguments (for algorithms) ar =
[T Generate test execution log file el Sk el EE i ee L
2 X 7 x
Test Descrigtion
New ~
Mame Initial “alue | Assigned n
Log File Path: DowviorkiUnttled bl
Test Wectors | Test varishles | Resources

Test Vectors  Test Variables Property page for selected element or section  Test Execution Status
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The desktop has a number of different panes that aide you in building and
running your test.

Test Browser — Shows the overall structure of a test. A test is made up of
Pre Test, Iterations, Main Test, Save Results, and Post Test. Use the Test
Browser to add elements to your test. These elements determine what
actions your test performs.

Test Vectors — Lets you define the parameters or test cases of your test.
The test vectors you define determine the number of iterations performed
by your test. Test vectors are automatically indexed during test execution.

Test Variables — Lets you define temporary variables used by your test.
Variables can serve both input and output functions in your test. You can
define variables that are declared in the Pre Test section of your test or in
the Main Test section of your test.

Properties — Shows the properties of the test or the element you are
editing. The contents of this pane change when you select a section or
element in your test.

Desktop Help — Shows help about the element or aspect of the test that
is currently selected. For the full product Help, click Help > SystemTest
User’s Guide.

Run Status — Shows a summary of the test’s execution status.

Note Many areas of the user interface have shortcut menus. For example,
if you right-click in the Test Vectors, Test Variables, Run Status, or
Desktop Help panes, you can access these shortcut menus.
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Setting SystemTest Preferences

You can set SystemTest preferences by selecting File > Preferences... on the
SystemTest Desktop. This opens the MATLAB Preferences dialog box. Click
SystemTest in the left pane if SystemTest Preferences are not showing in

the right pane.

F-General SystemTest Preferences
e MAT-Files

‘Confirmation Dislogs A
‘o Source Control host Recently Used Test List

- Heyhoard furmber of entries: IE
F-Forts

----- Colors i

----- Command Window: VEES R e s

""" Command History [ Minimize SystemTest when starting a test
[+ EditorDebugger

------ Help [ Savetest befare FURRInG

..... Web

=101 ]

i

----- Current Directary

Array Editor

Time Series Tools
Figure Copy Ternplate
Report Generator
SystemTest
Instrument Cortrol

[F-Wirtual Reslity
[ Simulink

Ok I Cancel | Apply | Help |

Most Recently Used Test List

This option determines how many tests will appear on the SystemTest File
menu’s most recent files list. The default is 4 tests. If you change it to 0, no
recent tests will appear on the list. The maximum number is 9.
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Test Run Options

Select Minimize SystemTest when starting a test if you want the
SystemTest Desktop to minimize when a test starts running. This check box
is cleared by default.

Select Save test before running if you want SystemTest to save your test
before it runs. If this option is selected and you run a test that is not yet
saved, you will be prompted to name and save the test. This check box is
cleared by default.

Note You can save a test any time, before or after running it, by selecting
File > Save.

Viewing Test Results

SystemTest includes a tool called the Test Results Viewer that you can use to
view the results you have chosen to save for your test. You can launch the tool
from the SystemTest Tools menu by selecting Tools > Test Results Viewer.
You can also configure the SystemTest environment to launch the Test Results
Viewer automatically after all test results you specified have been saved for
each iteration and test execution has completed. For more information, see
“Analyzing Your Test Results” on page 1-28.
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Building a Test: An Example

This section builds a simple example to illustrate the four primary stages of
testing: planning, building, and running the test, and viewing test results.

The example uses a simple MATLAB expression to emulate a scalar
measurement during each iteration of the test. The example uses an arbitrary
formula dependent on the test vector named signal to generate the Y data.
The example tests each measurement to determine if it falls within certain
specified limits. If a measurement exceeds these limits, that particular
iteration of the test fails. By default, the test fails if any iteration fails, but
you can configure other pass/fail criteria.

The following sections provide more information about each stage, building
the example test along the way. If you prefer, instead of working through the
following sections to build the example, you can load it into SystemTest by
running the “MATLAB - Getting Started with SystemTest” demo from the
Demos page in the MATLAB Help browser (under MATLAB > SystemTest >
General) or by entering systemtest Simple Demo at the MATLAB command
prompt.

¢ “Planning Your Test” on page 1-7

e “Building Your Test” on page 1-8

® “Running Your Test” on page 1-26

® “Analyzing Your Test Results” on page 1-28

Planning Your Test

In this first stage, you must identify what it is you want to test. SystemTest
lets you specify input data, such as measurements from a model or device, and
compare this input data to some predefined limits. Based on this comparison,
SystemTest can declare whether a test passes or fails. Keep the following in
mind as you plan tests:

¢ Identify your test data and test vectors.

® Specify test limits and determine if these limits can be expressed as scalar
values. (The Limit Check element operates only on scalar data.)
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® Determine what operations your test must perform. Must certain
operations happen first or exist for others to follow? Which test vectors
should be indexed first?

® Determine pass/fail criteria for your test.
® Decide which test variables you want to save as test results.

After this planning, you can begin to construct your test, which is described
in “Building Your Test” on page 1-8.

Building Your Test

SystemTest provides a graphical integrated environment that you can use to
create and edit tests. Tests consist of elements, test vectors, and test variables.
You can use each of these entities to create a variety of test scenarios ranging
from a simple test that runs a series of elements once to a full parameter
sweep that iterates over the values of test vectors that you define.

The following sections show how to construct a test.

® “Starting SystemTest” on page 1-8

® “Structuring Your Test” on page 1-9

e “Creating a Test Vector” on page 1-10

® “Defining Test Variables” on page 1-12

¢ “Adding Elements” on page 1-14

® “Defining Pass/Fail Criteria” on page 1-22
* “Saving Test Results” on page 1-23

e “Test Execution Log” on page 1-24

® “Saving Your Test” on page 1-25

Starting SystemTest

Start by opening the SystemTest Desktop using the MATLAB Start button.
To open SystemTest, select Start > MATLAB > SystemTest > SystemTest
Desktop.
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Alternatively, you can execute the systemtest command from the MATLAB
command line.

SystemTest displays the desktop on your screen. See “A Quick Tour of
SystemTest” on page 1-3 for an overview.

Structuring Your Test
SystemTest divides tests into three sections.

Pre Test — This section is used to execute test elements in order to perform
any test set-up operations, such as initializing variables, loading data from
a file, and initializing system resources. Using Pre Test variables, you

can assign an initial value to a test variable that persists between Main
Test section iterations (unless another element in Main Test modifies the
value). Pre Test is not mandatory, but it can be used if your test requires
set-up operations to be performed.

Main Test — Main Test defines the test elements that need to be performed
across the parameter space defined by your test vectors. In this section
Main Test variables are initialized before each Main Test iteration, which
lets you assign an initial value to a test variable each time the Main Test
runs. This is useful if your test variable has a derived value such as being
indexed by a test vector or is the result of a MATLAB expression. You

add elements in this section.

In the SystemTest desktop, Main Test is provided as part of Iterations.
Iterations specifies the number of times the Main Test section will be
run. This is determined from the test vectors you define. The SystemTest
desktop also offers a Save Results area for you to specify which test
variables you want to save as test results at the end of each Main Test
iteration.

Post Test — In this section you can perform any cleanup work necessary
at the completion of the Main Test section, such as clearing workspace
variables, closing a file, or freeing system resources.

For more detailed information about the sections of the test, see “Working
With the Sections of a Test” on page 2-2.

The following figure illustrates the structure of a test in SystemTest.

1-9
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Test Structure

Pre Test
pre fest element "
g
Main Test H main test variables
main test element [
ITERATIONS
test veciors

save results

Post Test

post test element "

Creating a Test Vector

Test vectors are composed of values derived from a MATLAB expression. You
can use any MATLAB expression that evaluates to a 1-by-N matrix or cell
array to define your test vector. Using test vectors, you can iterate through
a range of values to see how a system performs. Test vectors constitute
parameterized testing in SystemTest. They are the test cases for your test.
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For tests with multiple test vectors, the product of the lengths of the test
vectors defines the number of iterations the test performs. For example, if you
define the test vector [10 20 30], the test runs three times, using a value

of 10 for the first run, 20 for the second, and 30 for the final run. If you add

a second test vector with three other values, the total number of test runs
would be nine. SystemTest iterates through each vector in combination with
the other vector as though the test were a group of nested FOR loops—the
outermost loop being the first test vector in your table and the innermost loop
being the last test vector. The Iterations section in the Test Browser shows
the total number of test iterations defined by your test vectors.

For the example, use the vector [pi/15:pi/15:4*pi] which defines 60 values
for our test vector ranging from pi/15 to 4*piin pi/15 increments. To specify
this test vector in SystemTest:

1 Click the New button in the Test Vectors pane.

SystemTest adds a new test vector with default values to the Test Vectors
pane.

Test ¥Yectors [ 4

| wew | Eat.. | % & | F% |
Mame “ector Yalues fter...

E.] TestVect..[1:1:10 [12345E6..| 10

Test Yectors I Test VYariahles I

2 Assign a name to the test vector by clicking the Name field. For this
example, name the test vector signal.

3 Assign a value to the test vector by clicking the Vector field. Enter the test
vector specified above for the pi values.

1-11
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Test ¥ectors Ed I
‘ Py | it | 4+ 3 | B |

Mame Wector Walues |fer...
Eaignal [pid! Sepif S 4*pi] |=1=60 .. | BO

Test Wectors I Test Variables I

After you create the test vector, in the Test Browser pane, the Iterations
section label updates to include the number of iterations defined by the test
vector. It should say Iterations (60).

Defining Test Variables

SystemTest uses test variables to define temporary storage variables that a
test acts on or generates. You assign test variables in the Pre Test or Main
Test sections of your test.

You can define Pre Test variables or Main Test variables. Using Pre Test
variables, you can assign an initial value to a test variable that persists
between Main Test section iterations (unless another element in Main Test
modifies the value). Pre Test is not mandatory, but it can be used if your test
requires set-up operations to be performed.

Main Test defines the test elements that need to be performed across the
parameter space defined by your test vectors. Main Test variables are
initialized before each Main Test iteration, which allows you to assign an
initial value to a test variable each time the Main Test runs. This is useful if
your test variable has a derived value such as being indexed by a test vector
or is the result of a MATLAB expression. You add elements in this section.

The example test requires three test variables:
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e Y — Contains a value that will be calculated from the signal test vector
at each iteration

® HiLimit — Contains the upper limit for Y that you do not want the signal
to exceed

e | owLimit — Contains the lower limit for Y that you do not want the signal
to go below

To create these test variables in SystemTest:

1 Click the Test Variables tab at the bottom of the SystemTest Desktop
to access the Test Variables pane.

2 Click the New button to create a Pre Test or Main Test variable. Select
Main Test Variable. SystemTest adds a new test variable, named Var1, to
the Test Variables pane.

Test Yariables a X
|New' Ecit.. ‘ + § | 3 |

Mame Initial %'alue Aszigned In
HH sar Mairs Test

Test Yectors I Test Variahles I

3 Assign a name to the test variable by clicking the Name field and entering
the test variable name. For this example, enter VY.

4 Set the test variable’s initial value by clicking the Initial Value field and
entering a value. For the example test variable Y, enter 0.

1-13
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Note If you do not provide an initial value, it will default to empty, that is
Vari = []; in MATLAB code.

Test ¥ariables A X
| Mew = | Ecit. | 4+ 3 | P~ ‘

Mame Initial %alue Azsigned In
EEl hE 0 Mhain Test

Test Wectors I Test Vatiahles l

5 Repeat steps 2 through 4 to create the remaining two test variables, using
the settings listed in the following table:

Variable Name Initial Value Assign in
HiLimit 1 Main Test
LowLimit -1 Main Test

Adding Elements

Elements are the actions that a test performs. SystemTest includes the
following set of elements, listed in alphabetical order.

¢ [F — Implements a logic control operator

¢ Limit Check — Specifies the comparison to be performed of the value under
test and the limit (or limits)

e MATLAB — Executes any MATLAB statements

® Plot — Graphically shows the value of any test variable or vector, as the
test is executing, as either scalar or vector plot

1-14
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¢ Simulink — Runs a Simulink model. Note that you need to have a license
for Simulink to use this element.

® Stop — Implements a logic control operator

® Subsection — Creates a new section in a test that you can use to group
elements within

Note Some MathWorks products, such as the Image Acquisition Toolbox, the
Data Acquisition Toolbox, and the Instrument Control Toolbox, provide their
own elements that integrate those products’ capabilities within SystemTest.
If you have licenses for those products, those elements will also appear in
the elements list.

For more information about using the basic elements, see Chapter 2, “Working
With the Basic Elements”.

You add elements to a section in your test; however, not all elements are
available in all sections. You can, for example, use a MATLAB element
anywhere within a test, but you can only use the Limit Check element in
the Main Test section.

To illustrate using elements, let’s continue with our example. This test uses
three elements in the Main Test section:

Element Description

MATLAB Use a MATLAB expression to assign data to Y that is
dependent on the test vector signal.

Limit Check = Compare the value generated in the MATLAB element to
the specified limit and see if the Y test variable exceeds
the upper or lower limit you defined in your HiLimit and
LowLimit test variables.

Scalar Plot Plot the current test variable values and see whether the
test variable exceeds the upper and lower limits.

To add these elements in SystemTest:

1-15
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1 Select the section of the test in which you want to add the element. For this
example, click Main Test in the Test Browser.

t & | x|

| Mewy Eletnett -

=-_] untitled
----- Pre Test
El-iterations (60)
. -Main Test

2 Specify the element you want to add to the test section. For this example,
click the New Element button and select MATLAB. SystemTest adds
a MATLAB element to the Main Test section of your test and opens the
MATLAB element property page in the Properties pane of the SystemTest
desktop.

Teskt Browser [ (Properties - MATLAB

LI ‘ X | MATLAE Script

=] untitled 1
%-----Pre Test
[ Merations (60)
. El-Main Test
o lmaTiaE
Save Results
- Post Test

| Mewy Element -

3 In the Properties pane, type the following M-code in the MATLAB Script
edit box. This MATLAB code calculates a value for Y that is dependent
on the test vector signal.

Y = sin(signal)+ rand -.5

1-16
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Properties - MATLAB A X

MATLAE Script

17T = =zin({=sighal)+ rand -.5
2

For each iteration, SystemTest evaluates the MATLAB expression and
assigns a value to Y.

Add the Limit Check element to the Main Test section of the test. With
the MATLAB element selected, click the New Element button, and click
Limit Check. SystemTest adds a Limit Check element to the Main
Test section of the test and opens the Limit Check properties page in the
Properties pane. For this example, the Limit Check element must follow
the MATLAB element in the test.

Note You can reposition an element in a test by selecting the element
and then clicking the up and down arrows in the Test Browser toolbar.
You can also drag and drop elements within Main Test. You cannot move
elements between test sections.

1-17
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Test Browser [-4 | Properties - Limit Check

| Mewy Eletrent =

t 3| x|

~Conditions

& _a Untitled For this element to pass

I All roves must evaluste totrue Clogical AND)

If thiz elemert fails

I Current iterstion cortinues

|New‘f “a|><|

Test Vatiable Operator I Lirnit

1 = -

Tesk ¥ariables 72 X
| Mew | Edi.. | + 3 | g ‘
Mame Initizl %alue Aszighed n
HH v 0 hain Test Azzign date to;
FH HiLirmit 1 Mair Test
FH LowLimit |- Mair Test

Notice that the Limit Check element icon in the Test Browser shows
a red x, which indicates that information is missing. The corresponding

red outlining in the Properties pane highlights any fields that require
configuration.

5 Specify the limit comparison operations in the Limit Check element.

a In the Test Variable column, click the drop-down list and select a test
variable you created in step 4. For this example, select Y.

b In the Operator column, click the drop-down list and select the
comparison you want to perform. For this example, pick the
less-than-or-equal-to operator, <=.

1-18
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¢ In the Limit column, click the drop-down list and select the test variable
you want to compare to. For this example, select HiLimit, which is the
test variable you created earlier.

The following figure shows the configuration of this limit:

Propetrties - Limit Check

~Caonditions

For this element to pass

If this element fails

| All rovwes must evaluate to true (logical AND)

| Current iteration cortinues

o] 8|

Test Wariable

Operatar

Lirnit

¥ =

<=

HiLirmit

=

6 To add another limit comparison operation, click the New button in the
Properties pane. SystemTest adds a new row below the last limit you
specified. In this new row, set Test Variable to Y, set Operator to >=,
and set Limit to LowLimit.

The following figure shows the configuration of this second limit:

1-19
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Properties - Limit Check X
rConditions
Faor this step to pass
I All rowes must evaluate to true (logical AMNDY LI
If thiz step fails
I Current test run continues LI
| ey | t “ ‘ ?‘ |
“ariakle Operatar Litrit
¥ = <= || HiLimit ~|
¥ =] = ~ || Lowiimit hd

Aszigh data to:

| =

For each iteration of the Main Test, the MATLAB element’s expression is
evaluated and a new value assigned to Y. When the Limit Check element
runs, it determines whether the value of Y falls between the HiLimit and
LowLimit values. If Y is outside this range, the test iteration fails. The
default pass/fail criteria for the overall test passes the test only if both Y
variable evaluations succeed.

7 To view the test variables as the test runs, plot the data. To add a Plot
element to the test, click the New Element button, and select Plot >
Scalar Plot. SystemTest adds a Scalar Plot element to the Main Test
section, and opens the property page for the element in the Properties

pane.
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| Meswe Eletmert =

Properties - Scalar Plot
+ 3| x|

E-|_gj Untitled
> ----- Pre Test
[=-Hterations {60}
. El-Main Test

Flot Type

X Axis

[

I lteration

Mairum Mumber of Points to Display st Once

Ilnf

|New|f ‘|§|‘x|

' Axis Line Calor

Line Style

Line hizrker

v | =autor W I

LI Mo harker LI

With each Main Test iteration of the test, the Scalar Plot element updates a
figure window with data you selected.

8 Click the New button twice in the Properties pane and set the three

rows to match the following table:

Y Axis Line Color Line Style Line Marker
Y Blue Solid Point
HiLimit Red Dashed No Marker
LowLimit Black Dashed No Marker
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Properties - Scalar Plot A X

Plot Type

A\ i

X Axis

I tteration LI
Maxirmum Mumber of Points to Display &t Once

Ilnf

| ey | ? & | §|"‘ |

Y Axiz Line Colar Line Style Line Marker

W ¥ | Blue ¥ || Solid ¥ || Poirt el

HiLirnit ¥ || Red ¥ | Dashed ¥ | Mo Marker Jiatll
|| Lowlimit ¥ || Black ¥ || Dashed ¥ || Mo Marker Jkall

Defining Pass/Fail Criteria

You can define whether your test passes or fails by making SystemTest
monitor the outcome of any or all Limit Check elements during any or all
Main Test iterations. Your test’s threshold of success can range from the
passing of any Limit Check in any single test iteration to the passing of all
Limit Check elements in all test iterations. If your test contains no Limit
Check elements, there is no notion of pass/fail and no pass/fail information is
displayed. (Testing of this type is useful for experimenting with a system or to
explore its behavior rather than validate its performance.)

You can set any of the following conditions to define when your test passes:

e All Limit Check elements pass in all test iterations.

e All Limit Check elements pass in any test iteration.

® Any Limit Check element passes in all test iterations.

® Any Limit Check element passes in any test iteration.

You can configure this behavior within the test’s Properties pane. Click the

test name in the Test Browser (named Untitled by default) to open the
test’s properties and look for the section labeled This Test Passes If.
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Using the signal test example that you constructed in this section, set the test
to pass if all Limit Check elements pass in all test iterations.

Test Browser (-4l Properties - Untitled A X

| New Element > | & & | X | Test Resutts Save Options

B j Untitled IC:tMATLAEIU_Int'rtIed it jl
- Pre Test
E:I"-Itera‘tions (60} &+ Overyrite test resutts

7 Creste nevw numbered test resutts (2 Resuttz(1 1mat)

Thiz Test Pazzes If
Al limit check elemerts in an teration pass

i Ay limit check elemert in an teration passes

AHD
" Al iterations pass
.

[¥ Launch Test Results Yiewer after all results are saved

[V Generate test execution lag fils

Tesk ¥ariables a X

|New'|Ed'rt...|f ; |§|‘x|

Test Description

Saving Test Results

SystemTest saves the results from the iterations of your test in a MAT-file. You
must explicitly specify which test variables you want to save as test results.

SystemTest gives you the ability to save results at the end of each iteration.
Before you run your test, select the Save Results section in your test and
specify which test variables you want to save as test results. Click the New
Mapping button and then select from the drop-down list the name of the test
variable you want to map to a result. You can optionally specify a name for
the results that you want to save. The following figure shows the mapping of
test variables to test results:
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= ): SystemTest - Untitled.test*
File Run Tools Deskiop Window Help

® @ | j j H | @ ﬁ @ |Current Diredory:lD:Work
Test Browser 7 X |Properties - Save Results A X
t 3| x| ———————h———

| e Element Map Test Variables to Result
=] untitled F
j © | ey Mapping | f . | §_|'x |
Pre Test
E---Iterations {60) Test Yariahle Result
: i v v

Limit Check
[ scalar Piat

-
HiLimit ¥ |iimit
-

LaovavLirnit LovwLimit

Pogt Test

After you specify which test variables you want to save as test results, you
can specify the name of the MAT-file that SystemTest uses. Using this
MAT-file you can reload the test results into the base workspace. By default,
SystemTest names the file Untitled results.mat and puts the file in the
current working directory (visible in the SystemTest toolbar). To change the
name or location of the MAT-file, click on the test name in the Test Browser,
then in the Properties pane, use the Test Results Save Options field.

By default, each time you run the test you overwrite this file unless you select
the Create new numbered test results option on the test Properties pane.

Note Test variables that are not saved as a test result will be lost at the end
of the test execution.

Test Execution Log
When you run your test, SystemTest displays the status of the test in the Run

Status pane. This display contains basic information about your test:
® When your test started running
¢ Which section your test is in

* How many test iterations have passed or failed as defined by any limit
checks
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You can make SystemTest generate and save more detail about the running
test by enabling the test execution log file. This log is useful when you use
limit checks in your test and you want to see specific test iterations that
passed or failed. For example, instead of finding that a test iteration failed,
the log shows how far a test variable varied from the upper or lower limit
defined in a Limit Check element.

Note Because the test execution log renders HTML during the test, this
option results in the test taking longer to execute.

To enable the test execution log, check the Generate test execution log
file option on the Properties pane.

By default, SystemTest names the test execution log file

Untitled results.html and overwrites the file each time the test

is run. The options you set for your test results MAT-file also apply to your
test execution log file: the filename, location, and write options. See “Saving
Test Results” on page 1-23 to learn how to change these options.

See “Viewing the Test Execution Log” on page 1-28 to see what information
the test execution log generates.

Saving Your Test

SystemTest lets you save tests so that you can reuse them later. For example,
to save the signal test:

1 Select File > Save As to open the Save file as dialog box.
2 Select a directory location and enter mySavedTest in the File name field.

3 Click Save.

SystemTest saves the test as mySavedTest.test and renames your test as it
appears in the Test Browser. This does not rename the test results MAT-file
or the test execution log file. Their names are controlled separately from the
name of the test, as explained in “Saving Test Results” on page 1-23.
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Running Your Test

After you build a test, you are ready to run it. At run time, SystemTest
assigns values to test vectors and test variables in the order they appear in
the Test Vectors and Test Variables panes. Each test section runs elements
in the order that they appear in the Test Browser.

To execute your test, do one of the following:

e (Click the Run button.
e Select the Run > Run menu.

® Press the F5 key.

=} SystemTest - Uintit

File !—Run Tools Desk

.:E:J Run F5
m Stop ChrlC

Note While a test is running, you can stop its execution by pressing Ctrl+C
or clicking the Stop button on the toolbar.

Tracking Output
While the test runs, the Run Status pane shows summary test output.
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Run Status 2
B L2 ¥ | Ty W P e

Mumber of iterations: 60

Running Pre Test...
Running Main Test...
Running Post Test...

Saving HASimple_Demao_results.mat

lterations passed: 43
lterations failed: 17
Simple_Demo Fail
Test Completed

Log File Path: H:\Simple_Demo_results himl

B

=

=

-

If your test includes a Plot element, SystemTest creates the plot and updates
the plot during each iteration. Since Limit Check elements evaluate whether
an iteration passed or failed, they directly affect the data that appears in the

test execution log and the Run Status pane.

In the example test, the plot includes the high and low limits defined in the
Limit Check element, to show which test iterations exceed the limits.

1-27



1 Getting Started With SystemTest

1-28

<} simple_Demo: Plot Scalar Data: 28-Jun-2005 18:23:59
File Edit Wiew Insert Tools Deskiop ‘window Help N

Deds kRO [E|0H| =0

1581

0.5

05

lteration

Analyzing Your Test Results

After SystemTest runs your test, you can explore the results that SystemTest
generated. This section shows how to:

® View and interpret the test execution log.

® Inspect your test results with the Test Results Viewer.

Viewing the Test Execution Log

When you enable the test execution log, SystemTest saves information about
each test iteration in an HTML file. You can see the contents of this file by,
clicking the View Test Execution Log button on the SystemTest toolbar.
The generated output resembles the following:
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G /MATLAB,/Untitled.html

File  Edit

Wiew Go Debug Deskfop Window Help

- | = | A | Location:IC:MATLAB.I‘LInt'rtIed.ITtmI

Marne: mySavedTest
Start tirne: 28-Feb-2005 14:34:17
Mumber of iterations: G0

Pre Test

Wain Test 1 of GO
signal = 2.094395e-001

Limit Check

|Variable Name |Variable Value |Operator |LimitValue |Limit Name |Evaluates To

| N | -0.0B095 <= | 1 | HiLirnit | TRUE
| N | -0.06095 == | -1 | LoweLirnit | TRUE
Iteration 1 Passed

Wain Test 2 of GO

signal = 4.188790e-001

Limit Check

|Variable Name |Variable Value |Operator |LimitValue |Limit Name |Evaluates To

| ¥ [ 05135

= |

1 [ HiLimit

[ TRUE

| ¥ [ 05135

== |

-1 | LowLimit

[ TRUE

Iteration 2 Passed

-

4

The Main Test section of the test execution log shows each iteration. You
see the value of the test vector signal and determine the values the Limit
Check element used in evaluating whether the test passed. For the first
several iterations, the value of Y did not exceed either the high or low limits
so the iterations passed. You can also see this in the scalar plot drawn while
the test ran. For other iterations that failed, you can scroll through the test
execution log to find the values of Y.
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Viewing Test Results in the Test Results Viewer

To help you analyze your test results, SystemTest includes a tool, called the
Test Results Viewer, that provides a variety of plotting tools and the ability to
compare data. With this tool, you can see how your test results compare to the
test vectors used as inputs to your test.

You can start the Test Results Viewer by selecting it from the Tools menu.
You can also configure a test to launch the Test Results Viewer automatically
when the test completes. To do this, select the test in the Test Browser
and select the Launch Test Results Viewer after all results are saved
option on the test’s Properties pane.

The test vectors your test used and the test results you selected to be saved
appear within the viewer so you can immediately start to explore your data.
For any selected test vector or test result, you can see a summary of statistics
for its values in the Data pane. For example, after running the test, the
viewer opens showing the saved test results and signal test vector. Clicking
the Y test result shows information such as the highest and lowest values that
Y evaluated to during the test. It also shows the mean, median, and standard
deviation for all values.
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File Edit Wiew Insert Tools  Comstraints Results Plots Desktop Wwindow  Help

«): Test Results Viewer - C:\ Temp'Untitled_results.mat

=101x]

b B s 1o B

i e B HODBE&0 »x
| Resuts |
Neme L |value |7ye |
v =1x1 double=  Raw scalar
HiLlirnit =11 coublee  Raw scalar
LowLimit  =1x1 double= Raw scalar
W Test Vectors ‘
Meim alue | | Step 1. Explore your data and
sigral <B0x1 doul create constraints to view subsets.
Plot it using the toolbar buttons:
w Data Statistics: ¥ 2 Refresh \
Statistic Unconstrained Canstrained
M 134 1.34 |
it 144 144 J
Mean 00122 00122
Median 0.0581 0.0551 =l
Constraints a2 x
= t ¥
I signal [== «| |21 4 P
0209 1
4 | I
[ 500 Herstions
I Flot single iteration at & tine

The viewer has a rich selection of plotting capabilities that you can use to
visualize your test results. Plotting capabilities include line, scatter, time
series, surf, waterfall, and image plots. Using the signal example, you can
reproduce the line plot that your scalar plot element generated during the test.

1 Click the Line Plot button.

= ): Test Results Yiewer - 2\ Ten
File Edit Wiew Imserk

Tools

Al El e 1o 18

Dalagy

Line Plok
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2 In the Define Plot pane, click the X Axis list and select signal. Note that
you should choose signal or Auto values for the X-axis if you want to show
test vectors; line plots that use the X-axis for test vectors let you see how
each test iteration value corresponds to a test result.

3 Click the Y Axis list and select Y.

4 Click the Plot button.

You now have a line plot that resembles the scalar plot.

Line Plot: ¥ vs. signal
15 T T T T T T

05+ E

signal

You can make this plot show the HiLimit and LowLimit test results too.

1 In the Define Plot pane, click the Multiple Y Data option. The Y Axis
field expands to show all saved test results from your test.

2 Select the check boxes next to HiLimit and LowLimit.

3 Click the Refresh Plot button.
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Constraining Data for Further Analysis

Using the Test Results Viewer constraint capability, you can filter out data.
For example to see only the test iterations that passed the test, you can create
two constraints that screen out data that exceeds the upper and lower limits.

Note By default, the Test Results Viewer provides a list of test vector
constraints for you to choose from.

To create and configure the constraints:
1 Click the New Constraint button in the Constraints pane.

Constraints A X
e D & FF

New constraint button
The Add a New Constraint dialog box appears.

2 Click the Using a result or test vector option button.

3 Select Y from the list.

«): Add a New Constraink x|

€ U=ing & result o test vector

K =]
f Uszing a MATLAE expression

Example: var2=3.0

0],8 Cancel

4 Click OK. A new constraint appears in the Constraints pane.
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5 Repeat steps 1 to 4.

6 Click the check box next to the first constraint to activate it.

7 Make sure the operator is set to >=.

8 Click the constraint’s text field and change the constraint to -1.

9 Click the check box next to the second constraint to activate it.
10 Click the operator and set it to <=.

11 Click the constraint’s text field and change the constraint’s value to 1.

The green indicator bar beneath the constraints shows how many iterations
remain following the filter you applied. This is also reflected in the line plot,
which the viewer redraws after you apply the new constraints. As you can
see, only a subset of your test result remains.

Line Plot: Multiple variables vs. signal
1 T T T T T T

/

06| ' .
0.4 .

02 B

Multiple

L2k E
04k 4
L6 k

a8t : .

signal

You can just as easily show only the iterations of your test that failed by
reconfiguring the constraints you created to filter out data that is < -1 or
> 1. Alternatively, you can create a new constraint that uses a MATLAB
expression. For example:
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1 Delete the constraints you just created.
a Select the constraint row.

b Click the Delete button.

2 Click the New Constraint button in the Constraints pane. The Add a
New Constraint dialog box appears.

3 Click the Using a MATLAB expression option button.
4 Enter the expression Y<-1]|]|Y>1.
5 Click OK.

6 Click the check box next to the constraint.

The Test Results Viewer redraws the line plot to now show only those test
iterations that failed.

For more information about the Test Results Viewer, see Chapter 7, “Using
the Test Results Viewer”.
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Working With the Basic
Elements

Working With the Sections of a Test Describes the three sections of the

(p. 2-2) test and which elements you can add
to each one.
The Basic Elements (p. 2-4) Describes the basic elements, which

sections of the test you can add them
to, how they work, and their options
in the Properties pane.
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Working With the Sections of a Test

Each section of the test serves a different purpose and has different properties
that can be set in the Properties pane. Click on a part of the test or an
element in the Test Browser to see the properties for that section or element.

The descriptions of the elements in this chapter include a list of which sections
of the test you can use each element in. The following sections describe the
sections of a test. They are followed by a description of how to use the basic
elements.

Pre Test

The Pre Test runs once prior to any number of iterations through Main Test.
Pre Test can be used to perform general test setup such as:

® Opening a model.

Initializing variables.

® Accessing system resources, such as opening a file.

Initializing external test equipment.

In Pre Test, only test variables defined as a Pre Test variable may be modified
or assigned to. Pre Test variables are initialized once during Pre Test and
persist throughout the Main Test and Post Test.

In Pre Test you can add the following element types: Simulink, MATLAB,
Subsection, IF, Video Input, the three Instrument Control Toolbox elements,
and the four Data Acquisition Toolbox elements.

With Pre Test you can initialize Pre Test variables and run elements that you
only want to run once before any Main Test iterations. For example, you can:

¢ Add a Simulink element to run a model and assign baseline data to a Pre
Test variable.

e Add a MATLAB element to load a MAT-file or perform some other test
setup.
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® Create conditions with the IF element and follow up with a Subsection
element to define what to do when those conditions are met.

Main Test

The Main Test is run one or more times based on the number of iterations.
It is used to:

¢ Execute elements multiple times in order to perform batch testing or sweep
through a parameter space.
¢ Perform batch testing or parameter sweeps that require multiple

independent iterations using different test conditions for each iteration.

The number of iterations is defined by the number and length of test vectors
you specify. SystemTest executes Main Test once for each permutation of
values in the test vectors specified.

In Main Test you can add all of the element types.

Post Test

The Post test runs once after all Main Test iterations have executed or when
a run-time error occurs in Pre Test or Main Test. Post Test can be used to
perform test cleanup, such as:

® (Closing a model.

¢ (Cleaning up your workspace.

® Releasing system resources, such as closing a file.

® Returning external test equipment to a safe state.

In Post Test you can add the following element types: MATLAB, Subsection,

IF, Video Input, the three Instrument Control Toolbox elements, and the four
Data Acquisition Toolbox elements.
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The Basic Elements

The following sections describe how to work with the basic elements:
MATLAB, Limit Check, IF, Vector Plot, Scalar Plot, Stop, and Subsection.
The Simulink element is covered in detail in Chapter 3, “Using the Simulink
Element”.

To see the MATLAB, Limit Check, and Scalar Plot elements used in an
example, see “Adding Elements” on page 1-14.

Note You can rename any element or subsection by double-clicking its name.

MATLAB Element

The MATLAB element lets you run MATLAB scripts from within a test.
In addition to specifying any valid MATLAB script to execute, you can

incorporate any test variable into your code, as well as access any variables
residing in the MATLAB workspace.

Allowed Test Sections

The MATLAB element can be used in the following test sections:
® Pre Test

e Main Test

® Post Test

Test Browser A X |Properties - MATLAB A X

| Mewy Element =

LI | X | MATLAE Script

Ej Untitled 1 % enter MATLAE script here
Pre Test

E-iterations (1)
. [J-Main Test
o Bl maTias

- Post Test




The Basic Elements

Properties Pane
In the MATLAB Script edit field, enter any valid MATLAB script.

Limit Check Element

The Limit Check element determines test conditions are met by using scalar
comparisons. It can be used to:

¢ Compare measured data to expected data.
® Stop an iteration or an entire test if a test constraint is violated.

® Assign a test variable the logical value derived from the comparison(s)
for use by other elements.

Allowed Test Sections
The Limit Check element can be used in the following test section:

e Main Test
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Test Browser # X |Properties - Limit Check
| NewElermert - | & | X | ~Conitiar
B- —I'Ei Untitled For thiz element to pass
: ---- Pre Test I All roves must evaluste to true Clodical AMD) LI
[-Herations (1) : :
: I:;il---l\i!ain Test If this element fails %
R @ Litmit Check I Currert teration cortinues LI
: ‘- Save Results | | | |
ey E
- Post Test t ' ?‘
Test Wariable Operator I Litnit
- == ﬂJ h
Test Yariables E 4
|Newv Ed'rt...|‘|- Q|?"|
Marne I Initial %alue I Azsighed In I
Azsigh data to:
| I~

How to Use

1 Set your test’s passing conditions.

— The element can pass if all comparisons complete successfully (a
logical AND).

— The element can pass if one or more of the comparisons complete
successfully (a logical OR).
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2 Set your fallback procedure if the element fails. You can:

— Allow the current iteration to continue executing.
— Stop the current iteration and proceed onto the next iteration.
— Stop the test by proceeding onto Post Test.

3 Identify the SystemTest test variable you want to assign the logical value
derived from the comparison(s).

Note Aside from setting limit checks on individual elements, you can set
these properties for the entire test, reachable by clicking the test name in the
Test Browser, to determine pass/fail criteria for the test as a whole.

Properties Pane
You can set the following properties for the Limit Check element.

* For this element to pass — Choose between a logical AND (all
comparisons must pass) or a logical OR (at least one comparison needs to
pass) for the element to pass.

¢ If this element fails — Choose between continuing the test, stopping the
current iteration, or stopping the entire test.

¢ Test Variable — Value to compare to limit using operator.
® Operator — Boolean operator used to compare test variable to limit.
e Limit — Value to compare to test variable using operator.

® Assign data to: — Test variable assigned the logical value of this
evaluation. The logical value will be 1 if the element passes or 0 if the
element fails. If the element does not run, the test variable will be assigned
its initial value.

IF Element
The IF element provides logical control of a test by evaluating a condition.

The IF element allows sub-elements to run only when the IF element’s

condition evaluates to true. After adding an IF element, you should add one
or more elements to perform a specific task.
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Allowed Test Sections

The IF element can be used in the following test sections:
® Pre Test

e Main Test

® Post Test

Tesk Browser # X (Properties - IF l% A X

| Mews Element

3 G | X | Condition

=-|_] untitied [faise
= ----- Pre Test
[Z-Herations (1)

¢ [-Main Test

el

i Save Results

“-Post Test

Properties Pane
You can set the following property for the IF element.

¢ Condition — Enter a valid MATLAB expression that will evaluate to
true or false.

Vector Plot Element

The Vector Plot element is used to plot array or vector data over multiple
iterations. It is accessed off of Plot in the Elements list.

Use this element during the Main Test to generate plots of any test variables
containing array or vector data. You can change the number of iterations
displayed to as many as 16 (in a 4 x 4 matrix) using the Subplot Dimensions
fields. The default is 1 iteration.
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Allowed Test Sections

The Vector Plot element can be used in the following test section:

e Main Test
Tesk Browser # X |Properties - Yector Plot E 4
|NeWEIement' + 3 | X | PlUTTYFJE{«\g
= g Untitled
“-Pre Test f\/\/ plot <
[Z-tterations (1)
- = Main Test X Axis
“- |4 wector Plot
: St I:none: LI
~Save Results
------ Post Test |New|‘l ¥|?"|
W Axis Lire Color Line Style Line hiarker
T § =auto= Ll Salid ﬂ Mo Marker ﬂ
Test ¥Yariables "X
|New- Edit... | + 3 |?‘|
Maine I Iritial Yalue | Assigned In I " Subplat Dimensions

Rows

K [

Columns

1 =]

¥ Clear axes between terstions
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Plot Type
Choose one of the following plot types:

plot — Standard plot of X and Y.

semilogx — Semilogarithmic plot with logarithmic X-axis.
semilogy — Semilogarithmic plot with logarithmic Y-axis.
loglog — Log-log scale plot.

stem — Lines extending from a baseline along the X-axis.

Properties Pane
You can set the following properties for the Vector Plot element.

X Axis — Choose a test variable to use for an X-axis value.

Y Axis — Choose a test variable to use for a Y-axis value.

Line Color — Select a color to use for the line between each data point.
Line Style — Set the type of line to be drawn between each data point.

Line Marker — Choose a symbol to represent each data point.

Subplot Dimensions

Rows — The number of rows you want displayed in the Subplots window.

Columns — The number of columns you want displayed in the Subplots
window.

Clear axes between iterations — Applies only when you have one row
and one column to display. Selecting this option (default) rewrites the plot
with new data during each iteration. Clearing this option adds new data to
the plot during each iteration.

Scalar Plot Element

The Scalar Plot element is used to plot scalar data for each iteration. It is
accessed off of Plot in the Elements list.
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Use this element during the Main Test to generate a plot of one or more
scalar test variables.

Allowed Test Sections
The Scalar Plot element can be used in the following test section:

e Main Test
Test Browser # X |Properties - Scalar Plot A X
ey Element | |
| 1. ‘ X Flat Type
=-| g untitled
i-Pre Test ;’\/\/
H plot W
E-lterations (1) %J
. [Z-Main Test
[+ Soalar Plot X i
H ~Save Results I teration LI
“-Post Test
o & Macirmum Mumber of Points to Display &t Once
fint
| ey | 1' ‘ | §|"‘ |
Y Axis Line Color Line Style Line Marker
¥ | =auto= LI Salicl LI Mo Marker LI
Plot Type

Choose one of the following plot types:

® plot — Standard plot of X and Y.

¢ semilogx — Semilogarithmic plot with logarithmic X-axis.
* semilogy — Semilogarithmic plot with logarithmic Y-axis.
* loglog — Log-log scale plot.

® stem — Lines extending from a baseline along the X-axis.
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Properties Pane
You can set the following properties for the Scalar Plot element.

¢ Maximum Number of Points to Display at Once — Determine how
many points to show simultaneously. By default this is infinite such that all
points will be plotted. Use a MATLAB numeric that evaluates to a positive,
nonzero integer to set this field’s value.

* X Axis — Choose a test variable to use for an X-axis value.

* Y Axis — Choose a test variable to use for a Y-axis value.

¢ Line Color — Select a color to use for the line between each data point.
® Line Style — Set the type of line to be drawn between each data point.

¢ Line Marker — Choose a symbol to represent each data point.

Stop Element

The Stop element stops an iteration or an entire test unconditionally.

You can use the Stop element with conditional logic elements, such as the IF
element, to control the test’s execution.

Allowed Test Sections
The Stop element can be used in the following test section:

e Main Test
Test Browser A X |Properties - Stop E 4
| [t (Bl = t G | X | When this element runs
=] untitied | il testing stops |
?-----Pre Test Display Message
-ferations (1) I
| El-Main Test

9 Stop

~Save Results
~Post Test
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Properties Pane
You can set the following properties for the Stop element.

* When this element runs — Select a stop action. The Current iteration
stops option stops the current Main Test iteration. The All testing stops
option stops all Main Test iterations and runs Post Test.

¢ Display Message — Enter a message to display in the Run Status pane
when the test stops.

Subsection Element

Use subsection elements to organize one or more elements to maintain
readability of your test or to better manage complex test structures. Use
a subsection to:

® Group elements under a single root element.

® Organize tests.

® Manage complex test structures.
Allowed Test Sections
The Subsection element can be used in the following test sections:

e Pre Test
e Main Test
® Post Test
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Test Browser A X |Prnperties - Subsection

t ‘ | X | Test Description

| Mese Element =

E'j Untitled L Enker a description of the suksection here.

Properties Pane
You can set the following properties for the Subsection element.

¢ Test Description — Type in your description of the subsection.
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Element

The Simulink® element allows you to override the inputs to a Simulink model
with SystemTest test vectors and test variables. You can further map the
model’s outputs to SystemTest test variables for later processing by other test
elements. This means that you can use SystemTest to define, generate or load
input data, feed it into Simulink, run the model while iterating over the input
data, and map the outputs back into SystemTest.

Note To use the Simulink element, you must have a license for Simulink.

Before You Begin (p. 3-2)

Mapping Test Vectors and Test
Variables to a Simulink Model
(p. 3-4)

Using Simulink Model Coverage
(p. 3-18)

Prerequisite steps to take if you
intend to use the examples provided
with the procedures in this chapter

Describes how to map test vectors
and test variables to Simulink
inputs and Simulink outputs to test
variables

Describes how to use the Simulink
Verification and Validation model
coverage feature
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Before You Begin

This chapter explains the Simulink setup by having you recreate the Simulink
element that is part of the Inverted Pendulum demo. Before continuing, you
should load this demo from MATLAB and delete the Simulink element from
the demo.

The following steps describe how to do this:

1 Start MATLAB.

2 Open the Inverted Pendulum demo.
a Select Start > Demos to open the Help browser.
b Expand the MATLAB list from the left frame of the browser.

¢ Select SystemTest. The SystemTest demos open in the right browser
frame.

d Click “Simulink - Mapping and Overriding Simulink Data Using an
Inverted Pendulum Model.” An overview of the demo opens.

e Click the link “Open the demo in the SystemTest Desktop” at the bottom
of the page.

Alternatively, you can enter the following command at the MATLAB
command line:

systemtest InvertedPendulum
The SystemTest Desktop opens with the Inverted Pendulum demo loaded.

3 Click the Simulink element in the Test Browser.



Before You Begin

Test Browser

t & x|
E|j InvertedP endulum

----- Pre Test

[—:I---It_eratiuns (32

(= Main Test

| Mewy Element =

L
]
3
=
5
-

Limit Check
‘--Save Results
----- Post Test

4 Click the Delete element button in the Test Browser button bar or press
the Delete key.
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Mapping Test Vectors and Test Variables to a Simulink

Model

To help you learn how to use the Simulink element, this section walks you
through the configuration of the Simulink element for the Inverted Pendulum
test. The Inverted Pendulum demo includes both a model of the pendulum
and a model of a controller that keeps the inverted pendulum balanced.
Moving the bottom of the pendulum disturbs the equilibrium, causing the
pendulum to move and the controller to rebalance it. The Inverted Pendulum
test varies the mass of the pendulum, the mass of the cart the pendulum is
on, and the distance to the pendulum’s center of mass, testing the robustness
of the controller as it attempts to return the pendulum to equilibrium. Using
the Simulink element in a test lets you vary the model inputs and assess
the model outputs.

The following sections show you how to use a Simulink element in a test:

® “Adding a Simulink Element” on page 3-4
® “Overriding Simulink Model Inputs” on page 3-6
® “Mapping Simulink Model Outputs to Test Variables” on page 3-10

This section assumes you have loaded the Inverted Pendulum demo and
deleted the Simulink element, as explained in “Before You Begin” on page 3-2.

Adding a Simulink Element

To add a Simulink element to a test, click the New Element button in the
Test Browser and select the Simulink element. If you have a license for
Simulink, the New Element list contains the Simulink element, as shown in
the following figure.



Mapping Test Vectors and Test Variables to a Simulink Model

‘NewEIemer‘rt*| 4+ 3 | b4 |

-[ Data Acquisition k
Flok b
Instrument Control b
Image Scquisition

a Stop

& | MATLAB
Limit Check
?;g Subsection

o IF

SystemTest adds the Simulink element to the test and opens the Simulink
element Properties pane.

Test Browser 7 X |Properties - simulink L4
| New Elemert - | & | X ‘ Simuiink model
E---_ﬁlnuertedPendulum
; ~u
i-Pre Test | hd Uljl
- erations {32) _
£ Main Test Mappings I Model Cnveragel
I Y
—JMATLAB Define Model Overrides
[ Sirnulitik o3
[ vectar Piat Wew apping = | 4 & ‘ﬁ' |
: e Lirmit Check tapping Type I Sitnulink Data I SystemTest Data
-Save Results
----- Post Test

Specifying the Simulink Model

When you first add the element, the icon in the Test Browser has a red x,
meaning that the element requires some information. The Simulink model
field in the Simulink element Properties pane is outlined in red, indicating
that it is a required field. You must specify the model that the Simulink
element will interact with. If the model is on the MATLAB path, you can type
its name in the Simulink model field. If you are not sure of the name, or
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the model is not on the path, you can browse to its location using the browse
button.

For the Inverted Pendulum example, type systemtestpendulum in
the Simulink model field and press Enter. SystemTest opens the
systemtestpendulum model in Simulink and opens the Pendulum
Visualization window.

Overriding Simulink Model Inputs

Using test vectors and test variables, you can override the following Simulink
model inputs:
® Block parameters — Described in “Overriding Simulink Block Parameters”
on page 3-6

® Model and base workspace variables — Described in “Overriding to
Workspace Variables” on page 3-8

® Inport signals — Described in “Overriding Simulink Model Inport Signals”
on page 3-10

Overriding Simulink Block Parameters

You can override Simulink block parameters with SystemTest test vectors
or test variables. When you run the test, Simulink runs the model using
data provided by SystemTest. Overriding does not change your Simulink
model file; it only overrides in the test. The procedure for creating block
parameter overrides requires that you select your block in the Simulink
model, but everything else you need to do happens within the Simulink
element Properties pane.

To override a Simulink block parameter:

1 In the Mappings tab of the Properties pane for the Simulink element in
SystemTest, find the Define Model Overrides area and click the New
Mapping button, and select Select Block to Add.... This opens the model
in Simulink, if it is not already open.
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2 In the Simulink model window, click the block containing the parameter
you want to override. For this example, click the Pendulum block in the
systemtestpendulum model window.

3 In SystemTest, return to the Simulink element Properties pane and, in
the Define Model Overrides area, you’ll see that the Block 'Pendulum’
Parameter was added. If you click the New Mapping button, you'll see
that SystemTest also adds an entry to this menu for the block.

~Define Model Overrides —

L B

Mesay Mapping =

Inport Signal
Wiorkspace Yariable
Select Block ko add ..

Block 'Pendulum' Parameter

In the override table, the Simulink Data field shows that this entry is
linked to the Pendulum block but the question mark (?) indicates that no
parameter for the block has been mapped.

Define Model Overrides —
NewMapping*| ﬁ @ | §°‘ |

| Mapping Type Sitnulink Data | SystemTest Data
| |Black Parameter Perdulurm:? i I ¥

4 Select the parameter from the block that you want to map. Click the
Simulink Data field for the block and select a parameter from the list.
For the Inverted Pendulum demo example, click Pendulum:Mass of cart

(kg).

5 Specify the SystemTest test vector or test variable you want to map to this
block parameter. Click the SystemTest Data field for the block parameter.
This shows you all defined SystemTest test vectors and test variables
available for mapping. For this example, select cart.
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Define Model Crverrides -

Mewy Mapping = ﬁ \5 | a:x |
Mapping Type Sitnulink Data | SystemTest Data
Block Paratneter Pendulurn:mazs of cart (ka) LI” cart Li
maxyalue =

st_loggedsignal
st_outportzignal
| =t_towarkspace

rMap Simulink Data to Test Wariahles - -| LimitResult
Y e
| hew Mapping = | B | =~ P
- | Mapping Type | Sirnulink Data | sistance _L_!I

Overriding to Workspace Variables

You can use a SystemTest test vector or test variable to override either a
MATLAB base workspace variable or a Simulink model workspace variable.
This lets you define test values and conditions in SystemTest and have a

Simulink model act on them.

This section describes how you can use the values in the pend and distance
test vectors to override the model workspace variables masspend and
penddistance in the Inverted Pendulum demo.

To override workspace variables:

1 In the Define Model Overrides area of the Simulink element Properties
pane, click the New Mapping button and select Workspace Variable.
SystemTest adds a row for a new mapping of this type.

Define Model Overrides -

Mewy happing - | ﬁ‘
Inport Signal

"Warkspace Variable

? Select Block to add ...
Block 'Dukl’ Parameter
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2 Select the workspace variable you want to override. Click the Simulink
Data field of this row to see all available base workspace variables and
Simulink model workspace variables. For the Inverted Pendulum example,

select masspend.

[ Define Model Overrides —

‘ | Mesy Mapping = f a& | ?‘ |
I Mapping Type Simulink Data SystemTest Data
! Elock Parameter Pendulurm:Mass of cart (ko) LI cart ll

-1 =

Wiorkspace Yatiahle

mazscatt (model workspace)

nd (madel -

penddistance (model workspace)

3 Specify which SystemTest test vector or test variable you want to map to
the Simulink workspace variable. Click the SystemTest Data field of this
row to see all available test vectors and test variables. For this example,

select pend.

i Define Madel Owverrides

|Newrv1apping"| f ﬂr ‘ ?x ‘ ‘

Mapping Type

Simulink Data SystemTest Data

Elock Parameter

Pendulum:Mas=s of cart (kg) LI cart

Workspace Wariable

mazspend (model workspac... ™™

Qe

trisvallie
st_loggedsighal
st_outpartzighal
=t_toworkspace
LirnitResul

cart

distance i

4 Repeat steps 1 to 3 to override the Simulink model workspace variable
penddistance with the SystemTest test vector distance.

3-9



3 Using the Simulink Element

3-10

Define Model Cverrides -

ey Mapping = f 5/ | §|"‘ |
Mapping Type Simulink Data SystemTest Data
I Elock Parameter Pendulum: Mass of cart (ka) :J cart _1|
‘Workspace Variable masspend (model workspace) _‘ﬂ pend ﬂ
Wotkspace Vatiable penddistance (model woarksp.. :'_| distance L '

Overriding Simulink Model Inport Signals

As with block parameters and workspace variables, you can use SystemTest
to override a model’s inport signals. This lets you externally manipulate the
input signal of a Simulink model.

You use the same procedure to map an inport signal that you use for mapping
block parameters and workspace variables. Click the New Mapping button
and select Inport Signal. SystemTest creates a new row for the mapping.
Then you can choose the inport signal to override from the Simulink Data
field and select the SystemTest test vector or test variable to be mapped from
the SystemTest Data field.

The Inverted Pendulum demo example does not override any inport signals.

Mapping Simulink Model Outputs to Test Variables

Using test variables you can assign the output from the following types of
Simulink model data:

® Logged signals — Described in “Mapping Simulink Logged Signals to Test
Variables” on page 3-11

® Qutport signals — Described in “Mapping Simulink Outport Signals to
Test Variables” on page 3-13

® To Workspace blocks — Described in “Mapping Simulink To Workspace
Blocks to Test Variables” on page 3-14

After you map model outputs to test variables, you can incorporate the model
data into SystemTest. This section shows you how to map this data for the
Inverted Pendulum example.
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Note The output from Simulink models can only be mapped to SystemTest
test variables. You cannot map this output to SystemTest test vectors.

Mapping Simulink Logged Signals to Test Variables

Logged signals are a way to obtain outputs from a model without adding more
outports. Using logged signals, you can identify a particular signal and map
the output to a SystemTest test variable.

To map logged signals to a SystemTest test variable:

1 In the Map Simulink Data to Test Variables area of the Simulink
element Properties pane, click the New Mapping button. From the list,
select Logged Signal. SystemTest adds a row for a new mapping of this

type.

~Map Sirmulink Data to Test Variahles -

i PrlEnny Mappingvii ﬁ‘ "g“ | -
. Lljl;ll;lE!Ij '_:lil;IFIEI| g I

Cukpork Signal
To ‘Workspace Block

2 Specify the signal you want to capture. Click the Simulink Data field
to see all the signals in the model. For the Inverted Pendulum example,
select pendout.

Note If you added logged signals to your model and they do not appear
in this list, click the refresh button, on the Properties pane next to the
model name, to update the list.
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—Map Sitmulink Data to Test Wariables
ey Mapping = t .l, | ?‘ |
Mapping Type Sitnulink Data SystemTest Data
Logged Signal pencout ;I =
Al zignals
pendout

3 Specify the SystemTest test variable to which you want to map the output.
Click the SystemTest Data field and select a test variable. For the
Inverted Pendulum example, select st _loggedsignal.

~Map Simulink Data to Test Wariables

Mesy Mapping - t & | ?‘ ‘
Mapping Type Zirnulink Data I ZystemTest Data
Logged Signal pendout LI] =X
(]

linit

titme

values

maxwvalue

=t outportzignal
=t_toworkspace ﬂ

SystemTest creates the mapping to the test variable.

~hlap Simulink Data to Test Variables
Mewy Mapping - f 1'- | a‘x |
Mapping Type Sitruliek Data SystemTest Data
Logged Signal pendout LI zt_loggedsighal LI
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Mapping Simulink Outport Signals to Test Variables

SystemTest lets you map all outport signals to a test variable for further
processing in SystemTest.

To map Simulink outport signals to a test variable:

1 In the Map Simulink Data to Test Variables area of the Simulink
element Properties pane, click the New Mapping button. From the list,
select Outport Signal. SystemTest adds a row for a new mapping of this

type.
Q-Map Zitmulink Data to Test Variables:

pe

| Mewy Wapping -

Logged Signal

il o utport Signal
| I_‘ To Workspace Block

2 Specify the outport signal you want to capture. Click the Simulink Data
field and select a signal. For this example, click Outl.

~Map Simulink Data to Test Variahles -

Ak

Mewy Mapping ~

Mapping Type Sitnulink Data SwstemTest Data |
Logoed Signal pendout LI =t_loggedsignal LI
outpart Signal - I - I

All signals

3 Specify the SystemTest test variable to which you want to map the outport
signals. Click the SystemTest Data field and select a test variable from
the list. For this example, select st_outportsignal.

3-13



3 Using the Simulink Element

Map Simulink Data to Test Yariakles -

= Mapping*| f «5 | ?‘ |

Mapping Type Sitnulink Data SystemTest Dats
Logged Sighal pendout Ll =t loggedsignal ﬂ
Outport Sighal Ot bt -
;'
liFriit
time
ValUES
maxvaluie
=t_loggedsignal =
=t_outpartzignal
st_toweorkspace ﬂ

SystemTest creates the mapping to the test variable.

~Mag Sienulink Data to Test Yarishles -

Meswy Mapping - ‘.‘ %- | ? ‘
Mapping Type Sirnulink Data SystemTest Data
Lagged Sighal pendout LI =t_loggedszignal LI
Outport Signal ot L =t outportsignal ‘:|

Mapping Simulink To Workspace Blocks to Test Variables

When Simulink runs a model with To Workspace blocks, these blocks
save model information in the MATLAB workspace as variables. Using
SystemTest, this data can be mapped to SystemTest test variables.

This section shows how you create To Workspace block mappings in
SystemTest using the Inverted Pendulum demo as an example.

To map the To Workspace block:
1 In the Map Simulink Data to Test Variables area of the Simulink
element Properties pane, click the New Mapping button. From the list,

select To Workspace Block. SystemTest adds a row for a new mapping
of this type.
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~Map Sirnulink Data to Test Variables:

| Newhﬂapping'| + & | g

Logged Signal ne

Ckpork Signal

| o 70 Warkspace Eiln:u:|=:.

2 Specify the To Workspace block in the model that you want to capture.
Click the Simulink Data field and select the block from the list. For this

example, select To Workspace.

~Map Simulink Data to Test Yariables

To Warkzpace Block

Mewy Mapping = 1‘ ‘!v | ﬁ'x |
Mapping Type Sirnulink Data SystemTest Data
Logged Signal pendout L‘ zt_loggedsignal LI
Cutpart Sighal ot L[ =t_outpartsignal ﬂ
-1

3 Specify the SystemTest test variable to which you want to map the To

Workspace block. Click the SystemTest Data field and select a test

variable from the list. For this example, select New Test Variable... to

create a test variable.
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~Map Simulink Data to Test Yariables

Mlewe Mapping ~ f “ ‘ ?x |
Mapping Type Sirnulink Data SysternTest Data

Logged Signal pendout l‘ =t_loggedsignal ll

Outport Signal Ot L‘ =t_outportsignal Ll

To Workspace Block To Workspace et 53
titne i
values
maxvalie

#t_loggedsignal

=t outportzignal
=t_toworkzpace
LitnitFesult

=Mew: Test Varishle .=

SystemTest opens the Editing Variable dialog box. Assign a name to the
test variable and optionally an initial value, and then click OK. Name the
test variable ToWSResult.

Editing: ¥arl

pd

B

Marne

ITu:uWSResurt

Initial value

Assigned in

fiain Test

024 Cancel
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SystemTest creates the mapping to the new test variable and adds the new

test variable to the list in the Test Variables pane.

~Map Sitmulink Data to Test Variakbles

Mewe Mapping - f -‘ ‘ ?x |
Mapping Type Simulink Data SystemTest Data
Lagged Signal pendout l‘ =t_loggedszignal ll
Outpart Sigral Outt | st_outportsignal ¥ |
To Wiorkspace Block To Wiorkspace l‘ Tuil‘:,fSResurt LI
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Using Simulink Model Coverage

The model coverage feature provided by Simulink Verification and Validation
allows you to generate coverage analysis metrics for a Simulink model,
which can be incorporated directly into your SystemTest test. Model
coverage metrics allow you to validate your model by identifying unexecuted
subsystems, unselected switch positions, or untaken conditional transition
paths. You can generate a cumulative coverage report, specify individual
coverage options, or inherit a model’s coverage settings.

Note To use the model coverage feature, you need a license for Simulink
Verification and Validation.

The following basic steps describe the typical work flow to use this feature:

1 Use an existing Simulink element or add one by clicking the New Element
button and selecting Simulink.

2 On the Properties pane, browse for your Simulink model using the browse
button next to the Simulink model field.

To see an example, you can run the Signal Builder demo by typing
systemtest SignalBuilderDemo in MATLAB.

3 Configure the Simulink element as described in this chapter, using the
Mappings tab of the Properties pane to define model overrides and map
Simulink data to test variables.

4 On the Model Coverage tab, which appears if you have a license for
Simulink Verification and Validation, select the Enable model coverage
check box. The following figure shows the Signal Builder demo.
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Scalar Plot

(- Save Results

&' |nherit coverage metric settings from the madel

Test Browser # X (Properties - Run the model A X
| New Element ~ | & & | X | Simuiink madel
E|j SignalBuilderDemo systemtestsicar. md
Pre Test Isys‘temtes‘tsfcar LI % [
El-iterations {4)
H I::il---Main Test Mappings:  Model Coverage
Fun the madel v Enable model coverage

H ™ Override model coverage metric settings
“Post Test
~Inherited Coverage Metrics
—Coverage Instrumentation Path O for whale model)
il
Browmvse...
—Coverage Metric:
¥ Decizion Coverage ¥ Condition Goverage
¥ MEDE Coverage ¥ Lack-up Tatle Coverage
Test Yariables A = ¥ Signal Range Coverage
| Mew ™ | Edt.. | ' ‘ | ?x | ~hlap Coverage Data to SystemTest Variables
Matne Initial Walue | Azsigned I ‘ Mews Mapping = | B ‘ F* ‘
Ea T LIENES Cowverage Path Metric SystemTest Data
systemtestsfcanT ... | Look-up Table Co... LI COvEerage LI

Test Vedorsl Test Wariables | Resourcesl

5 If you want to use the model coverage settings you already have on the
Simulink model, select the Inherit coverage metric settings from the
model option. Then go to step 9.

6 If you want to override the existing settings, select the Override model
coverage metric settings option.
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Properties - Run the model A X

Sirmulink model
systermtestsioar. md

Isystemtestsfu:ar ll % lﬁ

Mappings Model Coverage
[V Enable model CoOverage
" Inherit coverage metric settings from the model

i Override model coverage metric zettings

—Owerridden Coverage Metrics
—Coverage Instrutmertation Path (0 for wwhole model)
!

Brovese. . |

—Coverage Metrics

V¥ Decision Coverage V¥ Condition Coverage

¥ mcoo Coverage v Look-up Takle Coverage

v Signal Range Coverage

7 Click the Browse button to specify the Coverage Instrumentation Path.
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C-f@ systentestsfoar

—E Engine

—3+ Threshold Calculation

—E Tzer Inputs

—3 Vehicle

—2 shift logic(dtateflowChart)
F-2+ transmission

| | ol

Ok Cancel

8 In the Coverage Metrics field, select the types of coverage your test
requires. The selected coverage types will be generated and shown in the
coverage report.

Coverage Metrics
[V Decision Coverage ¥ condition Caverage
¥ MCDC Coverage [+ Look-up Table Coverage

v Signal Range Coverage

9 Use the Map Coverage Data to SystemTest Variables field to map
coverage metrics to test variables. Click New Mapping and select Full
Coverage Instrumentation Path if you want coverage data below the
root you specified under Coverage Instrumentation Path, or select
Select Path to Map... if you want to pick an alternate coverage path,
which must be within the coverage instrumentation path. If you select the
latter, your Simulink model will open and you can select a block to specify
an alternate root for your coverage path.
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10 Select the Metric you wish to map to a test variable, and specify the test
variable to use under the SystemTest Data column.

Map Coverage Data to SystemTest Wariables

t 3T

Mesey Mapping =

Coverage Path

hetric

SystemTest Data

systerteststcarMhreshold Calculstiondrterp_down

Look-up Takle Coverage ll

COvVErage

[ ]

11 Run your test.

12 View the coverage report by clicking the link in the Run Status pane.

Run Status

Murber of iterations: 4
Running Fre Test. ..

Funning Main Test...
Running Fost Test...

A

Launch Model Coverage Feport for 'Bun the

trodel’

Saving CATemphvSignalBuilderDemo_results.mat

Test Completed

*

=4

-

For more information on the model coverage feature, see the Using
Model Coverage section of the Simulink Verification and Validation

documentation.
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%V systemtestsfcar Coverage Report Ol =]
File Edit “ew Go Debug Deskiop ‘Window Help L]
. O | & | % | Location:IC:J’TEMPISignalBuiIderDemo_resun314952053.html LI
Summary | Details | Signal Ranges | Help
=l
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Model
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m c1 MCDC TBL m c1—
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Details:
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Using the Instrument
Control Toolbox Elements

The Instrument Control Toolbox provides several elements to use in
SystemTest.

Introduction (p. 4-2) Introduces the Instrument Control
Toolbox elements

Example: Measuring a Generator’s  Provides a basic example of
Frequency (p. 4-3) using Instrument Control Toolbox
elements to test a device
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Introduction

Instrument Control Toolbox Elements

This chapter describes how to use the Instrument Control Toolbox elements
with SystemTest.

The Instrument Control Toolbox elements provide a way to bring data from
instruments into a SystemTest test, or to transmit data from your instrument.
You can use these elements along with the other elements in SystemTest to
create tests for Simulink models and other applications.

Note To use the Instrument Control Toolbox elements, you need a license
for the Instrument Control Toolbox. These three elements will not appear
in SystemTest without this license.

The Instrument Control Toolbox provides three of elements that you can use
in SystemTest:

¢ To Instrument — For sending commands or data to your instrument
® From Instrument — For reading data from your instrument

® Query Instrument — For querying your instrument status or properties

You can configure these elements to communicate with your instruments by
using SystemTest resources supported by the Instrument Control Toolbox.

Accessing Resources

If your MATLAB installation includes elements that require resources, the
SystemTest Desktop includes a Resources pane that lets you access the
resources available through these toolboxes. For example, if your MATLAB
installation includes the Instrument Control Toolbox, you will see the
Resources pane. Resources are toolbox-specific. For example, an Instrument
resource might be configured to connect to a device over your computer’s
serial port.



Example: Measuring a Generator’s Frequency

Example: Measuring a Generator’s Frequency

To illustrate how to use some of the Instrument Control elements in
SystemTest, this section provides a step-by-step example.

In this example a SystemTest element configures a signal generator to
produce signals of various frequencies, which are measured by an oscilloscope
configured by other SystemTest elements.

The signal generator is a Hewlett-Packard 33120A at GPIB address 5, and
the oscilloscope is a Tektronix TDS 210 at GPIB address 4. For this example,
the generator output is fed directly to the scope input. The generator will
be programmed to generate signals of 1500, 5000, and 7500 Hz, while the
oscilloscope will measure each signal’s frequency.

The steps in this example are:

e “Setting Up the Signal Generator” on page 4-4

e “Setting Up the Oscilloscope” on page 4-7

® “Taking the Measurement” on page 4-9

* “Saving Test Results” on page 4-10

® “Running the Test and Viewing Test Results” on page 4-11
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Setting Up the Signal Generator

The first element in the test programs the generator to output signals of
various frequencies. To test at three frequencies, the test be comprised of
three test cases, i.e., three iterations. This is a one-way communication to the
generator, so you use a To Instrument element.

1 Open SystemTest from MATLAB by selecting Start > MATLAB >

SystemTest > SystemTest Desktop. You can also just type systemtest
at the MATLAB command line.

2 When SystemTest opens, ensure that the Launch Test Results Viewer
after all results are saved check box is selected in the Properties pane.

3 No set-up is required in the Pre Test, so the elements of this test are all in
the main test, so click Main Test in the Test Browser.

4 Add an element by clicking New Element > Instrument Control > To
Instrument.

«): SystemTest - Untitled test™

File Run Tools Deskiop ‘Window  Help !

OO0 d| e &2l

Test Browser

4

| Mewe Element ~

* 3| x|
[ Data Acquizition  #
Plot (]

Instrument Cortral #
Image Acguisition  #
Simulink

€ stop

4] maTLap

Limit Check

?ZE Subzection

& IF

The element appears in the browser as To Instrument.
5 Double-click To Instrument, rename it Set Generator, and press Enter.

6 From the Properties pane’s Select an instrument resource list,
select New Instrument Resource. The instrument resource is the
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communication channel between MATLAB and your instrument, in this
case the generator at GPIB address 5.

7 In the Editing: Instrumentl dialog box, enter Generator in the Name field.
8 Click Create to create an instrument resource.

9 In the New Object Creation dialog box, select GPIB in the Instrument
object type list. Select the appropriate Vendor (in this example, ni
for National Instruments), Board index (0), and instrument Primary
address (in this example, 5).

«): Mew Object Creation

Define ohject

Instrument ohject type: I GPIB

~Configure object crestion

Wendor:

I hi
Eoard index: l]
B

Primaty address:

\_uuu L]

Cancel

10 Click OK to return to the Editing: Instrumentl dialog box, where the
instrument object is now filled in and selected for this resource (GPIBO-5).

Editing: Instrument1 x|

Mame:

IGenerator

Instrument Chject

Select an instrument object for this resource.

11 Click OK to apply this resource and return to the Properties pane in the
SystemTest Desktop.

12 In the Command text field, enter frequency followed by a space to
separate the text from the variable that will follow. This is the command to
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set the frequency of the 33120A generator, as described in the instrument’s
reference manual proved by the vendor.

13 Click Data source and select New Test Vector. The name of the vector
you create for setting the generated frequencies is called genfreq. Enter

that text in the Name field, and set the Vector field to [ 1500 5000 7500],
including the brackets.

Editing: TestY¥ectorl x|

|Name

Igenfreq
Wectar

Jr1500 5000 7500]

Walues

|[1 500 5000 7500]

terations

B

OK | Cancel |

14 Click OK to return to the SystemTest Desktop.
Notice that the Iterations node in the tree now says (3). Because you
entered three values in the test vector, the test is comprised of three

iterations, one for each frequency value in the test vector.

15 Keep the Send variable data as setting as String. The generator is
expecting string values for its commands.

16 Set a pause value of 2 seconds. This allows the generator to settle before
you measure its output.

The element should now resemble the following figure:
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«): SystemTest - Untitled.test™

File Run Toolz Desktop Window  Help
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’ """ Pre Test I Generatar LI
C-terations (3)
| E-Main Test ~Message data and format
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""" Save Results Command text:
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Data source:
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|New|Ed‘rt...|ﬁ* 3 |§' | 2
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Test Wectors | Test Variables | Resources
4

Setting Up the Oscilloscope

You use a To Instrument element, which provides a one-way communication
to the oscilloscope, to program the scope to measure frequency.

1 Add an element by clicking New Element > Instrument Control > To
Instrument.

2 Double-click To Instrument in the tree, rename it Set Scope, and press
Enter.

3 As before, create a new instrument resource, but this time call it Scope.

Create a new instrument object for it using Board index 0, and GPIB
primary address 4.
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4 For the command text, enter measurement:immed:type frequency. This
puts the scope in the frequency measurement mode, as described in the
instrument’s reference manual provided by the vendor.

There is no test variable or pause required for this element, so the element
looks like the following figure:

«): SystemTest - Untitled.test™

File Run Toolz Desktop Window  Help
PO D WS % 2| s o

| Mewe Element ~

t 3| x|

rInstrument resource
& j Untitled Select an instrument resource:
> ----- Pre Test I Scope LI
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. [5-Main Test ~Mezsage data and format
@ Set Generstor Message data: measurement : immed: type freguency
[ Set Scope Cornitnand text:
""" Save Results Imeasuremem:immed:type frequency
""" LG Data source:
| |
Send variable data as:
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|New|Ed‘rt...|ﬁ* §|§'|
| Mame Wectar Walues terations
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Test Wectors | Test Variables | Resources

To see the resources you created for communications with your two
instruments, click the Resources tab at the bottom of the SystemTest
window. You can see the Generator and Scope resources, along with their
GPIB settings.
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Wy e oy, oYy ey

Resources

| e ~

Ed‘rt...|‘l‘ §|§|"‘|

Mame

Resource ldentifier

@ Generator

GPIBD-5

@ Scope

GPIED-4

Test Wectors | Test Variables I Resources I

Paus
s

Fodows goas ity

Taking the Measurement

With the generator and scope set up, you can take the measurement with the
scope using a Query Instrument element, which sends the command to the

scope for taking the measurement.

1 Add an element by clicking New Element > Instrument

Control > Query Instrument.

2 Double-click Query Instrument in the tree, rename it Measure with
Scope, and press Enter.

3 Use the existing instrument resource called Scope, by selecting it in the
Instrument resource list.

4 Enter the command to query for a measurement by typing
measurement:immed:value? in the Instrument query command field.

5 Select Store complete response, and select the Empty input buffer
after read check box.

6 From the Interpret data as list, select String (this scope returns ASCII
strings), and select the Convert string value to a numeric result check

box.

7 From the Assign data to list, select New Test Variable. For the
oscilloscope’s frequency measurement, name the test variable scopefreq.
It needs no initial value.

The element now looks like the following figure:
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Saving Test Results

To view the results of your test, you must first specify the test variables you

wish to save as test results. This is done in the Save Results Properties
pane.

1 Click Save Results in the test browser tree.

2 In the Properties pane, click New Mapping.

3 From the Test Variable list, select scopefreq. This test variable contains

the frequency measurements provided by the oscilloscope during each Main
Test iteration, as shown in the following figure:
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File Run Toolz Desktop Window  Help
0 Dceadms &2l = ®
Test Browser LA Sl Properties - Save Results A X
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Running the Test and Viewing Test Results

Now that the test elements are all created, you can run the test.

1 Run your test. When the test is complete, the Test Results Viewer displays
your test results.

2 You can explore and plot your test results using the Viewer. Alternatively,
in the Data pane, right-click the name scopefreq and select Export

result or test vector to workspace. This makes the variable available
in your MATLAB workspace.
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: Test Results Yiewer - C:\ Temp'Untitled_results.mat

D File Edit Wiew Insert Tools  Constraints  Results  Plots Desktop
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w Results |

Mame £ “alue Type
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3 To see the measurement results, at the MATLAB prompt type

format short g
scopefreq
scopefreq =
1501.5
5000
7500

This verifies that the signal generator is producing the expected signal
frequencies.



Using the Data Acquisition
Toolbox Elements

The Data Acquisition Toolbox provides several elements to use in SystemTest.

Introduction (p. 5-2) Introduces the Data Acquisition
Toolbox elements

Example: Testing a Voltage Provides a basic example of using

Regulator (p. 5-3) Data Acquisition Toolbox elements

to test a device
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Introduction

Data Acquisition Toolbox Test Elements

This chapter describes how to use the Data Acquisition Toolbox elements
with SystemTest.

The Data Acquisition Toolbox elements provide a way to bring analog and
digital data from a data acquisition device into a SystemTest test, or to send
analog or digital data from your device. You can use these elements along
with the other elements in SystemTest to create tests for Simulink models
and other applications.

Note To use the Data Acquisition Toolbox elements, you need a license for the
Data Acquisition Toolbox. These four elements will not appear in SystemTest
without this license.

The Data Acquisition Toolbox provides four elements that you can use in
SystemTest:

® Analog Input — For reading analog data from your data acquisition device
® Analog Output — For sending analog data to your data acquisition device
® Digital Input — For reading digital data from your data acquisition device
¢ Digital Output — For sending digital data to your data acquisition device

You can configure each test element to communicate with your data
acquisition devices for sending or receiving digital or analog data.
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Example: Testing a Voltage Regulator

To illustrate how to use some of the Data Acquisition Toolbox test elements
in SystemTest, this section provides a step-by-step example. The example
shows how to use the elements that send data to a device under test (DUT)
and receive data from a device under test, using both analog channels and
digital lines.

This example samples the response of a 5-V voltage regulator that is
stimulated with three different voltages of 4, 5, and 7.5 volts. The regulator
has an enable function controlled by a digital signal. In this example, you
collect 22,000 samples per second of the DUT response for 2 seconds.

All data going to and from the DUT is handled by a National Instruments
PCI-6035E data acquisition card. The example uses this card’s analog output
for the DUT stimulus, analog input for capturing the DUT response, and
digital output for controlling the DUT’s enable line. The test configuration is
shown in the following figure:

National Instruments

PCI-6035E

Analog Output
HW Chan 0

Shmu|us= DUT Response »| Analog Input
HW Chan 3

Digital Output
Enable Port O, Line 3

The steps in this example are

* “Sending Analog Stimulus Data to the DUT” on page 5-4
¢ “Enabling the DUT with Digital Data” on page 5-6
® “Receiving Analog Response Data from the DUT” on page 5-8
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® “Disabling the DUT with Digital Data” on page 5-9
¢ “Performing Data Analysis” on page 5-10

® “Defining Post Test Elements” on page 5-12

® “Saving and Viewing Test Results” on page 5-13

Sending Analog Stimulus Data to the DUT

Stimulus data is sent to the DUT from an analog output channel of your
data acquisition card.

1 Open SystemTest in MATLAB by selecting
Start > MATLAB > SystemTest > SystemTest Desktop.
You can also type systemtest at the MATLAB command line.

2 This example does not use the Pre Test section, so select the Main Test
section in the Test Browser pane.

3 Add an Analog Output element by clicking New Element > Data
Acquisition > Analog Output.

<} SystemTest - Untitled_test
File Run Tools Deskiop ‘Window  Help L

OOInD=E |5 &

| Mewe Element ~ ‘& @ | | ¢
B oe RO 11 Digital Cutput
Plat Q& ~nalog Output r
Instrument Contral ¥ IIJI} Digital Input k E
Image Acouisition D_E# Analog Input -
Simulink 3 -
@ stop
4] matLag !J
Limit Check
?ZE Subzection /
& F .
g - - > f 4

The new element appears in the browser tree, and its properties appear in
the Properties pane. SystemTest scans your computer for installed data
acquisition adaptors and devices. This can take several seconds.
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4 Double-click the new Analog Output node in the browser tree, and enter a
new name for this element, such as Stimulate DUT.

5 Since we have three test cases, we need to create a test vector containing
the three voltage settings to test against. Click the Test Vectors tab. The
voltage values for the stimulus to the DUT are held in a test vector. Click
New to create a new test vector.

6 Click the name TestVectori and enter a new name for your vector, such
as DUTstimulus.

7 Click the default 1 : 1 : 10 entry in the Vector column, and replace it
with the values for your test: [4, 5, 7.5] (be sure to include the brackets)
and press Enter. Notice that because there are three values in your vector,
the browser tree now indicates that the Main Test will run three iterations.
Each iteration will use one of the three values in the vector for the DUT
stimulus voltage.

8 In the Properties pane, select the adaptor and device to use for the test.
This example uses the nidaq adaptor, and the device is a PCI-6035E.

9 The example hardware configuration uses the card’s analog output
hardware channel 0 to provide the DUT’s stimulus. So select the check box
for this channel. The element will generate signals of 4, 5, and 7.5 volts, so
keep the default output range of [-10.0 10.0].

10 From the Data source list, select the DUTstimulus test vector.

11 Enter a value of 1 for Qutput rate. You are using a single static value
rather than a sampled waveform, so this is not critical.

12 Enter a value of 1 for Number of times to output data. The card will
hold its last programmed value, so you need to send it only once.

The Properties pane now looks like the following figure:
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Enabling the DUT with Digital Data
To send a digital enable signal to the DUT, use a digital output element.

1 Select New Element > Data Acquisition > Digital Output.

2 Double-click the new Digital Output element in the browser tree, and type
a new name for this element, such as Enable DUT.

3 Click the Test Variables tab.

4 Select New > Main Test Variable to create a new variable. You will create
two variables: one for enabling and one for disabling the DUT.

5 Click the name Var1, and replace it with the text DUTenable.

6 Click its empty Initial Value entry, and enter 1.
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7 Repeat steps 4 to 6 to create a second test variable, but name it DUTdisable
with an initial value of 0.

8 In the Properties pane for the Enable DUT element, select the adaptor
and device for sending this data. Again, you are using the nidaq adaptor,
and the device is a PCI-6035E.

9 The hardware configuration uses the card’s digital output port 0, line 3 for
the enable signal, so select the check box for this line.

10 From the Data source list, select the variable DUTenable.

The Properties pane now looks like the following figure:
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Receiving Analog Response Data from the DUT

The next element in the test samples the output from the DUT and assigns
the acquired data to a test variable.

1 Select New Element > Data Acquisition > Analog Input.

2 Double-click the new Analog Input element in the browser tree, and enter
a new name for this element, such as DUT Response.

3 In the Properties pane, select the adaptor and device to use for the test.
This example uses the nidaq adaptor, and the device is a PCI-6035E.

4 The hardware configuration uses the card’s analog input hardware
channel 3 to read the DUT’s response, so select the check box for this
channel. The expected signal will be about 5 volts, so keep the default
output range of [-10.0 10.0].

5 Set a sample rate of 22000. Because of hardware limitations, the actual
sample rate may not exactly match the value you specify.

6 In the Acquire field, specify to acquire data for 2 seconds. Set seconds in
the unit list to the right of the value field.

7 In the Assign data to field, select New Test Variable from the list. This
is where you specify what test variable to assign the acquired data to. The
Editing dialog box appears.

Editing: ¥arl x|

Mame

IVar1

Initial value
Jpaata
Azsigned in

JMein Test

Cancel |

8 Enter a name for the test variable, such as DUTresponse, then click OK
to create the test variable.

The Properties pane now looks like the following figure:
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Disabling the DUT with Digital Data

The next step is to disable the DUT with a digital output element that turns
off the DUT’s enable line. This element is similar to the Enable DUT element,
except it sends a different value to the DUT.

1 Select New Element > Data Acquisition > Digital Output.

2 Double-click the new Digital Output element in the browser tree, and
enter a new name for this element, such as Disable DUT.

You already created the test variable DUTdisable, which you will use in
this element.
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3 In the Properties pane for the Disable DUT element, select the adaptor
and device for sending this data. Again, you are using the nidaq adaptor,
and the device is a PCI-6035E.

4 The hardware configuration uses the card’s digital output port 0, line 3 for
the enable signal, so select the check box for this line.

5 From the Data source list, select the variable DUTdisable.

The Properties pane now looks like the following figure:

«): SystemTest - Untitled.test™

File Edit Run Toolz Desktop ‘Window Help
ool 8| 2|l =&
Test Browser # X |Properties - Disable DUT A X
|Nev\fEIemer‘ﬂv + 3 | 4 |
Select Hardware:
=-[_] untitled
, ..... Pre Test Adaptor:
E| erations (3) |nidaq LI
. E-Main Test bovine
[ stimulste DUT Sics:
1l Enatle DUT | Devz (PO-035E) =]
: E#DUTResponse
il Dizable DUT Port Ling
ave Results O o o
.post Test ] 0 1
O 0 2
I 0 3
O 0 4
O 0 5
Test Variables A X ] 0 5
|New' Ed‘rt...|‘l‘ lr|§|"‘| r U i
[Marne Initial *'alue Azsigned In
HH outenabie |1 Main Test
HH outdisable [0 Main Test
EH DUTresponse Main Test
Select Al Unselect All
Data source:
| DUTdisable |
Test Wectors I Test Yariables I Resources I
4

Performing Data Analysis

At this stage, you might perform any analysis or visualization routines on the
data generated by the DUT. You can do this in a MATLAB element.
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1 Select New Element > MATLAB.

2 Double-click the new MATLAB element in the browser tree, and enter a
new name for this element, such as Process Data.

3 In the MATLAB Script edit field of the Properties pane, enter any
MATLAB code that you need for analyzing your test variables. You
might be interested in measuring ripple, noise, regulation, or many other
characteristics. You can access the DUT response by referring to the test

variable DUTresponse. The stimulus data is available in the test variable
DUTstimulus.

The following figure shows a MATLAB element with only some comments
added in the Properties pane.
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Defining Post Test Elements

In this example, it is recommended to include an element in the Post Test
section to disable the DUT.

1 Click the Post Test section in the browser tree.

2 Create a digital output element set up like the element you made in
“Disabling the DUT with Digital Data” on page 5-9.

With the extra Disable DUT element, the test now looks like the following
figure:
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The Post Test section of the test could also perform any analysis that requires
completion of all the iterations of the Main Test.
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Saving and Viewing Test Results

Before running a test, you must specify which test variables you want to save
as a test result. In the Save Results Properties pane, you select the test
variable that you want to save and map it to a test result name.

Saved test results will be viewable with the Test Results Viewer. To launch
the Test Results Viewer, click on the test name in the Test Browser. In the
Properties pane, make sure the Launch Test Results Viewer after all
results are saved option is checked.
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Using the Image Acquisition
Toolbox Element

The Image Acquisition Toolbox includes a SystemTest element that you can
use to bring live video data into a SystemTest test.

Introduction (p. 6-2) Introduces the Image Acquisition
Toolbox element

Example: Acquiring Video Data in Shows how to acquire video data
a Test (p. 6-3)
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Introduction

This chapter describes how to use the Image Acquisition Toolbox element
with SystemTest.

The Image Acquisition Toolbox element, called Video Input, provides a way to
acquire live video data in a SystemTest test. You can use this element along
with the other elements in SystemTest to create tests for Simulink models
and other applications.

To learn how to use the Image Acquisition Toolbox element in SystemTest, see
“Example: Acquiring Video Data in a Test” on page 6-3.

Note To use the Image Acquisition Toolbox element, you need a license for
the Image Acquisition Toolbox. The Video Input element will not appear in
SystemTest if you do not.
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Example: Acquiring Video Data in a Test

This section provides an example that illustrates how to use the Video Input
element in SystemTest. The example uses the Video Input element to acquire
a single frame of video for each iteration of the test and uses the MATLAB
element to display the acquired image. The steps in this example are:

® “Adding the Video Input Element to a Test” on page 6-3

® “Saving and Viewing Test Results” on page 6-7

e “Running the Test” on page 6-8

Adding the Video Input Element to a Test

To create a test using the Video Input element:

1 Open SystemTest by selecting Start > MATLAB > SystemTest >
SystemTest Desktop in MATLAB. You can also just type systemtest at
the MATLAB command line.

2 In the SystemTest Desktop, start to create your test by selecting Main
Test and adding the Video Input element. In the Test Browser, clickNew
Element > Image Acquisition > Video Input.

= ). SystemTest - Untitled.test

File Run Tools Desktop Window Help

OO0t WS 8|

|NewEIement" ﬁ é | X |

-[ Data Acquisition vl
Plot ]

Instrument Cantrol

Image Acquisition  » ﬁf} Video Inpuk |

Sirnlink,
@ Stop

A | maTLaE
Limit Check
E;g Subsection

& TF
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SystemTest adds the Video Input element to the Main Test section of the
test and displays the Properties pane for the Video Input element. (You
can also add elements to the Pre Test or Post Test sections of a test but
this example does not require it.)

In the following figure, note the red x in the Video Input element icon in
the Test Browser. This red x indicates that the element is in an error state.
SystemTest outlines the required fields in red in the Properties pane.

Test Browser L8 Properties - ¥ideo Input E 4
| New Elemert ~ | 9 & | b4 |
Image Acguisition Device
= g untitied
;’-----Pre Test Adaptor:
-iterations (1) |WirwideD =l
| B in Test .
£ video Input e
. -Save Results | 1 (BM PC Camers) =]
"Post Test “ideo Format:
| RGBSS5_1 28296 Rd
Selected Source:
| input1 x|
Test ¥ariables A X Eirenizs il |
|Newv Edlit.. | + 3 | B |
Matne I Initial “alue I Mzsigned In |
Mumnber of frames:
il
Azsign data to:
| |

3 Specify the device you want to use to acquire image data in the Properties

pane for the Video Input element. You must specify the name of the adaptor
you want to use in the Adaptor field, which is a required field. (SystemTest
uses red outlining to indicate required fields that are not filled in yet.)
SystemTest can detect any image acquisition devices supported by the
Image Acquisition Toolbox that are connected to your system and fills in
this field with a default value based on the alphabetical list of devices, if one
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is available. For our example, in the figure, SystemTest sets the Adaptor
field to winvideo. If your system has other adaptors that can connect to
devices, select the adaptor that you want to use from the Adaptor list.

After the Adaptor field is set, SystemTest fills in the Device, Video
Format, and Selected Source fields with default values. SystemTest
populates the drop-down lists associated with each field with all available
options for the field. Adaptors can support multiple devices and devices can
support multiple formats. SystemTest preselects the default values for
these fields but lists all available options in the drop-down lists associated
with these fields. The following figure shows the list for the Video Format
field:

= ): Properties - Yideo Input =10l =]

rnage Acguisition Device

Aclaptar:

| weinvideo LI
Drevice:

| 1 (BM PG Camera) =]
“Wideo Format:

Selected Source:

inpLE! =]
Preview Window |

Mumber of frames:
fi
Assion data to:

I =

4

4 Specify the number of frames you want to acquire at each iteration of the
test in the Number of frames field, which is a required field. For this
example, we only need to acquire one frame for each iteration, so set this
field to 1.
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5 Specify the name of the SystemTest test variable that the acquired video
data will be assigned to at each iteration. This is a required field. You can
select a test variable from the list or create a new test variable by selecting
New Test Variable.

Azsign dats to

If you select New Test Variable, SystemTest opens the Editing dialog box.
Assign a name to the test variable, or accept the default name, and click
OK. You do not need to assign the test variable an initial value.

Editing: ¥arl x|

Mame

I‘-f'ar1

Initial value
Assigned in
[Min Test

E Cancel |

SystemTest adds the new test variable to the list in the Test Variables
pane.

6 Optionally, verify the Video Input element settings by clicking the Preview
Window button. SystemTest opens a Video Preview window and displays a
live video stream from your camera. You can use this to verify that your
hardware is configured correctly. You should close the preview window
before running the test.

7 To complete this example test, add a MATLAB element to the Main Test
section. In this MATLAB element, call the MATLAB image function to
display the image frame acquired at each iteration.
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L Al Properties - MATLAB A X

Test Browser
| Mew Elemert - | ¢ B | X |
=-[_] untitied
> ----- Pre Test
Z-tterations (1)
. [E-Main Test
8 videa Input
#lmatLan
~Save Results
“-Post Test
Test Yariables A X
|New' Exit... | + 3 | g |
Matne Initial % alue Aszsigned In
HH var Miain Test
Test Yectors I Test vatiables I

MATLAE Script

1 image (Varl) |

This completes this example test illustrating how to incorporate image data
into SystemTest. In a real testing application, you can define test vectors that
determine the number of iterations of your test that SystemTest performs.
You can also compare test variables against defined limits in the Limit Check
element and specify pass/fail criteria.

Saving and Viewing Test Results

Before running a test, you must specify which test variables you want to save
as a test result. In the Save Results Properties pane, you select the test
variable that you want to save and map it to a test result name.
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Saved test results will be viewable with the Test Results Viewer. To launch
the Test Results Viewer, click the test name in the Test Browser. In the
Properties pane, make sure the Launch Test Results Viewer after all

results are saved option is selected.

Test Browser 2 X |Properties - Save Results

+ 8| x|

| Mewwy Element =

~Map Test Yariables to Results

=[] untitied

= | W47
~Pre Test | ew Mapping | B S T

E%]-"Iterations ) Test Warishble

Rezuft

Main Test “arl
- video Input

LI ar]

Bl mat e
Save Results
- Pogt Test

Running the Test

To run the test, do one of the following:
¢ (lick the Run button.

¢ Select the Run > Run menu.

® Press the F5 key.

While the test executes, SystemTest reports on the progress of the test in

the Run Status pane.
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Run Status LS

Marne: Untitled
Start time: 20-Sep-2005 11:18:19
Murmber of iterations: 1

Running Pre Test...

Running Main Test...

Running Post Test...

Saving CATempiUntitled_results. mat

Test Cormpleted

After the test runs, the Test Results Viewer will launch. In the Viewer, select
the type of plot you want to create. For this example, select Image Plot from
the Plots menu or click the Image Plot button in the Test Results Viewer
toolbar.
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Using the Test Results
Viewer

This chapter explains how to use the Test Results Viewer to explore and

analyze your test results.

Before You Begin (p. 7-2)

A Quick Tour of the Test Results
Viewer (p. 7-4)

Viewing Your Test Results (p. 7-6)

Refining Your Test Results (p. 7-24)

Viewing Simulink Time Series Data
(p. 7-32)

Prerequisite steps to take if you
intend to perform the examples
provided with the procedures in this
chapter

A quick overview of the Test Results
Viewer

How to render plots of your saved
test results

How to use constraints to filter the
test results shown in your plots

How to plot Simulink values with
time data
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Before You Begin

The examples in this chapter use saved test results from the Throttle demo.
You can follow the explanations by loading and running the Throttle demo
from the MATLAB command line. The Throttle demo is configured to open
the Test Results Viewer upon completing a test.

See the SystemTest Demos page for an explanation of the Throttle demo.

Note This demo will not be listed if you do not have Simulink installed.

To prepare for the rest of this chapter:

1 Start MATLAB.

2 In MATLAB, select Start > Demos to open the Help browser opens.

3 Expand the MATLAB list from the left frame of the browser.

4 Click SystemTest. The SystemTest demos open in the right browser frame.

5 Click “Simulink - Validating a Throttle Body Model.” An overview of the
demo opens.

6 Click the link “Open the demo in the SystemTest Desktop” at the bottom
of the page.

Alternatively, you can enter the following command at the MATLAB command
line:

systemtest ThrottleDemo

After the SystemTest Desktop appears, run the loaded test. Do one of the
following:

e (Click the Run button.
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= ) SystemTest -

File FRun Tools

® @0

Teskt Browser

| Mewe Eletmert =

s e,

® Or press the F5 key.

® Or select the Run > Run menu.

SystemTest runs the Throttle demo test, saves the specified test results, and
opens the Test Results Viewer when it finishes.

) Test Results Yiewer - H:\ThrottleDemo_results.mat =1of x|
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Plot it using the toolbar buttons:
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A Quick Tour of the Test Results Viewer

The Test Results Viewer is organized to show you the test vectors you specified
as inputs to your test, the results saved from your test, and tools you can use
to plot and examine your test results.

Plot choices Plotting tools Plot display options

) Test tesults ¥iewer - HiThrottleDemao_results,mat o [=] 53 |
File di e sert o Constraints Results  Ploks Desktop  Window  Help
[ E e o
= P ; / \ T
s 2 H&| haanis 0HEx 8 B\DEa0 = x
W Resuts
hiane Line Plot: position_sirn vs. ndex
Seleosiion - 7 - 87— ; : ; ; _ Plotted data
Friocton sim <7500t doules Row ey
FH posiion_norm <11 double> Faw:scalar 8651 ; i
FH position_imit <11 doublex Raw scaler A it
Data browser = = L i Selected dat
W Test Vectors elecie ara
855
Hetne |vvaiue |
Do <51 doities .
HH Mass 045020, @
EH stitfness  <6x1 double= c aasl
— g el /
W Data Statistics: position 7 Refresh
Stetistic Unconstrained Constrained 8351 ! J i
= s e il l
M 231 231 a3 W .14\
isen o4 e84 il e
Medien e o6 =l 8251 [‘\'\\ !'“\ i
= 2 L 2 st =20 340 i
= s E 280 280 300 e
!
meoey |[FHE|ETE] L E E:Line Plot 1 "%
Fwes  [= =] 05 = f———— |pottype [AfLine | valiepict ot unconstrained data wih S0 lners) [Eeort.| — VQerS of
= Wariakls Vall
1 xa [ = o [ e [ vee | | selected data
Data constraints 7] T stness [ ][5 e = B T |
s position_sim - A'J
wi  Slafamm 2] -+ fowemm s Bl
I <00 tertore Testvedter | vabe
= e — B
Pt singeferston o e e - e L
oompsam | | i 8E o
Plot display options

The test results and test vectors from your test are available in the Data
pane, which is a compact data browser. You choose your plot type, set your
display options to include what appears on the different axes, and plot your
data. The plotting tools let you select data from the plot to examine, and
you can see the actual values that resulted in individual plot points in the
Current Iteration pane, which will open automatically when you select a
plot point. If this pane is not visible, select Desktop > Current Iteration.
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“Viewing Your Test Results” on page 7-6, “Refining Your Test Results” on page
7-24, and “Viewing Simulink Time Series Data” on page 7-32 explain how to
use the Test Results Viewer to plot and examine your test results.
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Viewing Your Test Results

This section explains how you analyze your test results by using the Test
Results Viewer. It contains the following sections:

¢ “Reserved Keywords” on page 7-6

* “Browsing Results” on page 7-6

® “Generating Plots” on page 7-7

e “Exploring Plots” on page 7-11

Reserved Keywords

The Test Results Viewer has several reserved keywords that you cannot use
as a test result name or as a derived result name. These keywords are:

* time

® testrun

® testruns

metadata

® data

If any of these keywords are used as a test result name, they will be prepended
with "st_" when loaded in the Test Results Viewer. If you try to use these
keywords as a derived result name in the Test Results Viewer, you will get
an error dialog.

Browsing Results

“Viewing Test Results in the Test Results Viewer” on page 1-30 notes that the
Test Results Viewer contains a data browser within the Data pane. This area
of the viewer is one of the first things you see when the Test Results Viewer
opens. It shows you the test variables and test vectors your test used, and it
shows information about their values in the Data Statistics area.

These data statistics summarize the values of a test result or test vector
across all of the tests. For example, the Throttle demo varies the parameters
for mass, damping, and stiffness of a Simulink model. Test vectors vary
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Simulink block parameters for 90 test iterations, and SystemTest saves
how these changes affect the position of a simulated throttle opening in the
position_sim test result.

If you click position_simin the Results area of the Data pane, the Data
Statistics area shows you a summary of statistical information for all 90
iterations. In this example, you have not defined any constraints on your data,
so statistical information for the constrained and unconstrained columns is
the same. See “Creating and Applying Constraints” on page 7-24.

Ev Data Statistics: position_sim S Refresh |
Statistic Unconstrained Conztrained

High 86.5 86.5

Loy 23.4 23.4

(LN 6351 B5.1

hedian 54.5 54.5

=D 266 266

“Generating Plots” on page 7-7 explains how you can further explore your
test results.

Generating Plots

The Test Results Viewer has a plotting capability that helps you understand
your test results. You can determine how values of different inputs (test
vectors) affect the overall test results.

To generate any plot:
1 Click the button corresponding to the type of plot you want to generate.
The plot buttons are below the menu bar. For example, click the Line

Plot button. See “Choosing a Plot” on page 7-9 for an explanation of your
choices. You can also use the Plots menu to generate plots.
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= ): Test Results Yiewer - C:' Ten
File Edit Yiew Insert Tools o

| [ & Lo
Dalagy

Line Plok

2 Choose the data to use for your X-axis and Y-axis in the Define Plot pane.
For example, select *Auto* from the X Axis list and position_sim from
the Y Axis list to show the simulated throttle position trajectories at each

test iteration. See “Choosing a Plot” on page 7-9 to understand which data
types are available on each axis.

Define Plot: Line Plot 1

A X
Plat type: | Line S l “alid plot of unconstrained data with 90 line(s)
P P =] =]
Shiowy I Ll as | subpla... L‘ =t
e and I j as I subplo... Ll o
i
Mutipsle ¥ Deta Copy Settings | Refresh Plat |

3 Choose a different plot type if you do not want to use the default. To choose
a different plot type:

a Click Plot type in the Define Plot pane.

Define Plot: Line Plot

Plot type:

-

WoAwis:

Y Axis

position_sim

Multiple % Data

b Click the plot type you want to use. For the Throttle demo example,
use the default sine wave.
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4 Click the Plot button. The Test Results Viewer renders a plot based on
your selections.

Plots - Line Plot A X

Ha | h|aa®®(E 0|58 HODE O » x

Line Plot: position_sim vs. Index
90 T T T T T T T

position_sirm
[ay] o b | [un)
o [ {2 [mm]

o
[

(X3}
[}

20

1 1 1 1 1 1 1
0 100 200 300 400 500 G000 7oo 800
Index

Each line in the plot represents a test iteration. If it appears that there are
not as many lines as you had test iterations, it is possible that two or more
iterations generated similar enough results that they overlap.

Now you can analyze the plot. To help you with this task, you can:
¢ Explore the plot using the plotting tools available to you as explained in
“Exploring Plots” on page 7-11.

® Refine what results are shown in your plot as explained in “Refining Your
Test Results” on page 7-24.

Choosing a Plot

There are six types of plots. The line plot, mesh plot, and time series plot
types have additional subtypes available. Additionally, the Test Results
Viewer has rules for determining which test results you can plot on the X-axis,
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Y-axis, and Z-axis. These rules vary by plot type. The following table explains
these selections:

Plot Description

Line Standard line plot of Y versus X. Represents scalar or vector
data. The default is a wave line, but you can choose a square
Ty line sub type. The following data are allowed on each axis:

e X — Numeric test vectors

e Y — Numeric test results

Surf Wireframe surf plot based on X, Y, and Z coordinates.
Optional surface sub type available. The following data are

L"ﬁ"ﬁh‘- allowed on each axis:
e X — Numeric test vectors
e Y — Numeric test vectors

e 7 — Numeric test results

Scatter Standard scatter plot of X and Y where either axis can have
numeric test vectors or numeric test results.

%
s +¥

Time Series Plots time series data Y against time (X is always time).
Designed to represent Simulink time series object data. The
"_f_,l default is a wave line, but you can choose a square line sub

+—& type. See “Viewing Simulink Time Series Data” on page
7-32 for more information about this plot type.
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Plot Description

Waterfall Waterfall plot for vectors or time series. One vector or time
series can be displayed on each waterfall plot. The meaning
I__h.-'_'-_l_l of the X, Y, and Z axes is as follows:

e X — Is automatically selected to be “*Auto*” if the Z axes
is assigned to a vector-valued test result, or “Time” if Z
axes is assigned to a time series test result.

® Y — You can select either Test Run or Iteration. In
the former case, if a test is excluded by application of
constraints a gap will appear in the waterfall plot at the
Y position corresponding to that test. In the latter case,
lines representing the test result displayed on the Z axis
are always placed in consecutive Y positions.

® 7 — You can select either a single vector-valued numeric
test result or a single time series test result.

Image Lets you look at individual frames from an image sequence
saved during a test iteration. Data must be a supported
[ MATLAB Image format, and must be numeric test results
.;ﬁ whose size is compatible with an image, namely that:

e It has three or four dimensions.

® The third dimension has a length of 1 or 3.

Exploring Plots

This section describes the tools the Test Results Viewer makes available to
help you understand its generated plots. It contains the following topics:

* “Plotting Tools” on page 7-12 describes the tools available to help you
examine and understand the contents of a generated plot.

® “Viewing Individual Iteration Values” on page 7-12 shows how to focus on
specific iteration test results in a plot.

e “Highlighting Values in Your Plot” on page 7-16 shows how to distinguish
test results in a plot.
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¢ “Exposing Overlapping Plot Lines” on page 7-20 explains how you can view
individual lines in a plot that shows multiple test result values as the same
line.

Plotting Tools

The Test Results Viewer integrates the MATLAB Figure Toolbar, which
lets you examine and distinguish the test results shown in your plots. See
“Plotting Tools—Interactive Plotting” and “Data Exploration Tools” in the
MATLAB Graphics documentation for more information.

In addition, the viewer also supports the desktop arrangement tools available
in the MATLAB editor. See “Arranging the Desktop — Overview” in the
MATLAB documentation.

The Test Results Viewer adds the following features to the MATLAB Figure
Toolbar:

e Test run selection — Lets you click different test runs in the plot and see
the test vector and test results for that iteration in the Current Iteration
pane. “Viewing Individual Iteration Values” on page 7-12 shows an example
of how to use this.

® Lock the plot — Prevents constraints from changing the test results
displayed in the plot.

Viewing Individual Iteration Values

Every test iteration has its own representation in a plot unless you screened
it out with a constraint (“Refining Your Test Results” on page 7-24 explains
constraints). By clicking a line, marker, or surface in a plot with the test run
selection tool, you can see the information associated with that test iteration
in the Current Iteration pane.

For example, “Generating Plots” on page 7-7 demonstrates how to generate
a plot showing all test iteration results of the Throttle demo. You can use
the Test Results Viewer plotting tools to zoom in on areas of the plot and
determine which iteration was responsible for the result.

1 Click the Zoom In button.
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2 Move the mouse pointer over an area of the plot you want to investigate
further.

3 Left-click your mouse or click and drag over the area you want to see. The
plot redraws to show this area.

Line Plot: position_sim vs. Index
T T T T T T

95 B

position_sirn
[un] w0
i3] =]
T T
1

o0
=
T

1 1 1 b
150 200 250 300 350 400
Index

You can repeat zooming in until you have the level of detail you want.
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Line Plot: position_sim vs. Index
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4 To turn off the Zoom, click the Zoom In button again.

5 Click the Select an iteration button in the Figure Toolbar.

=} Plots - Line Plok 1

HE | @a®m|E| 0B« S&

| Select an ikeration

6 Click one of the plotted lines in the line plot. The viewer marks the line.
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The viewer simultaneously populates the Current Iteration pane with
information about the values for all test vectors and test results for your
selected test iteration. This lets you easily see what test conditions generated

a specific result.

Current Iteration X
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Highlighting Values in Your Plot

The Test Results Viewer lets you further distinguish your test results for any
given plot by letting you control how a plot renders the data on each axis.
This is useful in deciphering test results on a plot—especially when the initial
plot has a large number of test results closely grouped together. This section
explains how you use the Define Plot pane to modify the appearance of your
plot without modifying the underlying test results. (See “Refining Your Test
Results” on page 7-24 for information about modifying the test results used
to render a plot.)

The Define Plot pane provides four ways to distinguish plotted test results:

e Color
® Markers
® Subplot rows

® Subplot columns

For example, the Throttle demo shows the effect of variations in mass,
damping, and stiffness on a component of a Simulink model. The plot you
generated in “Generating Plots” on page 7-7 shows test results for of all test
iterations, but it is impossible to determine how changes to each test vector
affected this outcome. To distinguish the test results on the plot:

1 Zoom in on an area of the line plot so that you can see individual test
iterations (as explained in “Viewing Individual Iteration Values” on page
7-12).
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Line Plot: position_sim vs. Index
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2 In the Define Plot pane, click Show > Damping.

Define Plot: Line Plot 1 A X
Plot type: Lire :J “Walid plot of unconstrained data with 30 linels)
Kdis | routet | -~
Shiowye LI as I subplot Fowvws ¥ I =
N A | postion_sitm LI
and as I subplot columns ¥ I L
Mazs
Stiffress
=
huttiple % Data

3 Select color from the as list.

Copy Settings | Retfresh Plat |

4 Click the Refresh Plot button. The plot lines change to show a range

of colors.
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Line Plot: position_sim vs. Index
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You now have some idea how damping has affected the test results. You have
a cluster of blue, green, and red indicating that damping is the same value in
each cluster, which you can confirm by using the test selection tool to choose
lines and by viewing the value for the Damping test vector in the Current
Iteration pane.

You can modify the appearance of another set of test vectors to further
understand the test results. For example, the menu below Damping can be

used to distinguish variations in mass with markers.

1 Click the menu next to and.

il

Showe I Crarmiping x | as I color x | -

anicd I S | as I subplat colurmns | ¥ | =

Drarmiping

Mazs LI

Stiffress

Copy Settings | Refresh Plot |

2 Select Mass from the list.

3 Click the menu next to as and select marker type.
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E|

Showy I Drarnping i | as I calar i | =
anicl I Mass Vl as | subplot columns Vl = qr

subplat roves
subplat columns

4 Click the Refresh Plot button.

The viewer redraws the plot to show markers distinguishing variations in
mass. Notice how each cluster of lines has its own unique color and marker,
which shows that variations in damping and mass have a visible effect when

you run the model.

Line Plot: position_sim vs. Index
T T

76_ 30

1
250 270 280 2800 300 310 0

You can add two more rows using the + button in the Define Plot pane to
distinguish your test results further.
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[t ‘ calor - -

Add a row
-
a5 ‘ marker type ﬂ - +—]

Note These colors and markers do not necessarily show the same value
throughout the overall plot. The viewer cycles through all colors and markers
in the palette making it possible for different test result values to have the
same color or marker.

Exposing Overlapping Plot Lines

It is possible for plot lines and points to overlap and appear undistinguishable.
When multiple lines overlap, you can create subplots to distinguish the data
points.

For example, if you create a line plot for the Throttle demo with the X-axis
set to *Auto* and the Y-axis set to position_sim, the Test Results Viewer
renders a plot with plot lines in close proximity.
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This plot has 90 lines that are too close together to be able to discern clear
patterns. You can use the Define Plot pane to distinguish plots of test results
by placing the generated lines of a test in individual subplots. Each subplot
shows the test vector values associated with the test results being plotted.
The number of runs per test vector value determines how many subplots you
can generate. Using the Throttle demo, you can generate subplots based on
changes in damping, mass, or stiffness. For example, what effect did changes
in mass have on these test results? To show its effect:

1 In the Define Plot pane, select Show > Mass.
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Define Plot: Line Plot 1

A %
Plot type: Lire ﬂ “Walid plot of unconstrained data with 30 linels)
K dis |ttt - |
Shiowye LI as I subplot Fowvws ¥ I =
N A | postion_sitm LI
and ¥ as I subplot columns ¥ I L
Drarnping
I
=
Muttiple ' Data Copy Settings | Retfresh Plat |

2 Select subplot rows from the as list.

|
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3 Click the Refresh Plot button.

The viewer now shows three subplot diagrams, one for each value of the
Mass test vector.
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Refining Your Test Results

This section explains how you create and apply constraints to restrict the test
results to a subset of test iterations. You also see how to use a constraint to
walk through a set of test results. This section contains the following topics:

® “Creating and Applying Constraints” on page 7-24
* “Plotting Single Iterations” on page 7-30

Creating and Applying Constraints

Constraints are a Test Results Viewer mechanism that screen out test result
values. Constraints can be a single value, a range, or an evaluated expression.
Applied constraints result in plots rendered from a subset of test iterations,
and the viewer applies constraints immediately to all plots. This is useful
when you want to screen out or filter test results in your attempts to find

or understand the results of a test.

Using Default Constraints

The Test Results Viewer, when opened after a test run, has constraints
present but not applied. The viewer creates a constraint for each test vector
and defines the constraint’s range as a function of the full range of values in
the test vector. These default constraints let you see the immediate effect of
your test’s test vectors on the results of the test.

For example, the Throttle demo has three test vectors corresponding to
changes in damping, mass, and stiffness to a Simulink model. If you display a
line plot as explained in “Generating Plots” on page 7-7, you get a plot similar
to the following:
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This output shows that the test results group in small clusters. You can use a
constraint to see which of the test vectors cause this clustering.

1 Return the plot to the previous state by clicking the menu next to as and
clicking color, then click the Refresh Plot button.

2 In the Constraints pane, select the check box next to the Damping
constraint. The constraint becomes active showing all tests with a Damping
greater than or equal to 5.0, which is the lowest value in the range of test
vectors. All test results remain in the plot.

constraints ______________* X]
B D+ & F

|>= v”s_g vl 4 SJ—13 »
I Mass |>= v”g_15 vl 4 Jg— »

015 025

[ stittness |== v”15.0 vl 4 1@—20 4

| T Piot zingle teration st a tirme
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3 Click the right-pointing arrow at the end of the Damping constraint’s
slider.

4 Ji p— Click this arrow

2 i PE]

This advances the constraints slider by one value of the test vector, which
causes the first value of the Damping test vector to be removed from the test
results used in generating the plot. The viewer immediately applies this
constraint to the plot, which, in this case, removes the left-most cluster of test
results from the plot.

Line Plot: position_sim vs. Index

position_sim

20

1 1 1 1 1 1 1
1] 100 200 300 400 500 B00 700 500
Index

The constraint counter gives another way for you to see whether the
constraint affected the test results. In this case, if you set the constraint
value to 7, the bar shows that there are only 72 of 90 test iterations visible
because of the constraint you just created. Thus these 18 test iterations that
are screened out have a Damping test vector value greater than or equal to 7
(see “Creating a Test Vector” on page 1-10 to understand test vector values).
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Creating a Constraint
The Test Results Viewer lets you create a custom constraint based on the

following:

* A mathematical expression

® Scalar logical test results

® Scalar numeric test results

® String test results that have a value for each test iteration
o Test vectors

You can see an example for creating a constraint based on a mathematical
expression in “Viewing Test Results in the Test Results Viewer” on page 1-30.

A constraint you might want to create regularly would isolate test results
that have passed or failed. This is useful if your test contains a Limit Check
element that assigns data to a test variable that you choose to save as a test
result. When this test variable is saved, SystemTest records the test iteration
and whether the test passed or failed (represented by a 1 or 0); you can create
a constraint based on these test results. For example:

7-27



7 Using the Test Results Viewer

7-28

1 If you activated the Damping constraint in “Using Default Constraints” on
page 7-24, deactivate it now by clearing the check box next to Damping,
or delete it.

2 Click the New Constraint button.
Constraints A X

=D+ & T

New constraint button

The Add a New Constraint dialog box appears.

3 Click the list beneath the Using a result or test vector field to show the
list of test vectors and test results available for basing a constraint on.

= ). Add a New Constraint . x|

i+ Us=ing & rezult or test vector

Carmging w

llaz=z
Siffhess
position_norm
pasition_limit
pazz_fail

[8]:4 | Cancel

4 Scroll down and select pass_fail in this list. This is the name of the test
result that is used to save the Throttle demo’s Limit Check element’s
output.

5 Click OK. The viewer adds the new constraint to the Constraints pane,
but it is not active.

6 Select the check box next to the pass_fail constraint to apply it.
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7 Change the operator to ==. The value is already set to 0, representing
failed test iterations.

You now have a constraint set to show only those test iterations that failed.

Line Plot: position_sim ws. Index
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If you change the value of the constraint to 1 using the slider, you will show
only those test results that passed the Limit Check element in your test.
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Line Plot: position_sim vs. Index
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Plotting Single Iterations

The constraint option Plot single iteration at a time lets you step through
and see individual test results within the subset defined by the active
constraints. The plot shows only one test iteration until you choose to show
the next or previous one. The specific values for that test iteration’s test
vectors and test results appear in the Current Iteration pane. This is useful
when you want to know what combination of test vectors allow a test to pass,
or what values can lead to failure.

For example, if you follow “Creating a Constraint” on page 7-27, by the end
you have created a constraint that shows you all test iterations that have
passed. To see each iteration individually:

1 Move the slider for the pass_fail constraint back to 0.

2 Select the Plot single iteration at a time check box in the Constraints
pane.
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The Constraints pane changes to show a slider and the currently
displayed test iteration.

3 Move the slider or click the advance button to see the next iteration. You
see only those test results that match any defined constraints, which, in
this case includes only those tests that have passed.

[TT1R | 12080 terations

I+ Plot single teration st 2 time

|
lteration numker 11 1 =1 L4
1

Click here to advance

The Plots pane updates to show only the plotted line for that iteration.
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Viewing Simulink Time Series Data

The Test Results Viewer lets you plot test results over time. Simulink can
generate time series data when it runs a model, and SystemTest can use this
data to generate time series plots. Instead of knowing simply that a change in
a test vector resulted in a specific test result value, you can now know when
during the test that the test vector caused that test result value to be achieved.

This section shows how you plot test results containing time series data. The
examples in this section use the model from the Inverted Pendulum demo;
if you want to load this model and follow the examples in this section, see
“Before You Begin” on page 3-2.

Creating a Time Series Plot

Time series plots require that you have time series data. Your test results will
contain time series data because of any of the following:

* Time series data is generated from Simulink Outport Signals, Simulink
Logged Signals, and Simulink To Workspace signals.

® The time series data was explicitly created in a MATLAB element and
assigned to a test variable that was saved as a test result.

® The viewer created a derived result that represents time series data
constructed from Simulink structs (with time data) or log signals. These
new derived results have names derived from their original test result
name and value.

You can verify whether your test generated time series data by reviewing the
test results list in the Test Results Viewer’s Data pane. The viewer labels
time series test results as being of type Simulink.Timeseries (Simulink
saves time series data within the workspace in Model Data Logs objects).
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To create a time series plot:

1 Run the test in SystemTest.

2 Click the Time Series Plot button in the viewer.
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|
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3 In the Define Plot pane, click the Y Axis menu to show a list of test results
with time series data. The Y Axis field shows only test results with time
series values. The X Axis field is always set to Time in a time series plot.

Define Plot: Time Series Plot 1
Plot type: I Line j

W Axis Time

' Axis ! ll

=t_loggedsignal
=t outportsignal_signall

=t_toworkspace_systemtestpendulumToviorkspace
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4 Click the test result you want to use. For the Inverted Pendulum example,
click st_loggedsignal.

5 Click the Refresh Plot button.

The Test Results Viewer generates a time series plot with your selected data.

Time Series Plot: =t_loggedsignal vs. Time
150 T T T

100

a0 -

st_loggedsignal
(]

-100 -

-150
a 10 15 20

Tirne

m

At this point, you can use the data exploration and refinement tools explained
in “Viewing Your Test Results” on page 7-6 and “Refining Your Test Results”
on page 7-24 to make more sense of the test results in the plot.
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For example, you can use a constraint to step through each individual
iteration, by selecting the Plot single iteration at a time check box.
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As this example shows, the time series test result for a single test iteration
is composed of many values over time. There are many points with uneven
spacing reflecting the actual values of the signal over the time period.
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SystemTest Hot Keys

The following keyboard shortcuts are available in SystemTest.

Key Description

Alt+N Activates the New button to create a new test
vector.

F1 Opens Help.

F5 Runs a test.

Ctrl+C While a test is running, stops the test.

Ctrl+C When a test is not running, copies selection in
some parts of the user interface.

Ctrl+N Adds a new untitled test.

Ctrl+Q Closes SystemTest.

Ctrl+V Pastes the copied selection.

Ctrl+W Closes a test.

Ctrl+X Cuts a selection in some parts of the user
interface.

Ctrl+0 Gives focus to the Test Browser.

Ctrl+1 Gives focus to the Properties pane.

Ctrl+2 Gives focus to the Test Vectors pane.

Ctrl+3 Gives focus to the Test Variables pane.

Ctrl+4 Gives focus to the Resources pane.

Ctrl+5 Gives focus to the Run Status pane.




A SystemTest Hot Keys

Key Description
Ctrl+6 Gives focus to the Desktop Help pane.
Ctrl+7 Gives focus to the Elements.
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